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 Skycut Series D and V with SignMaster Pro 
 

September 3, 2021 
 

 
You can expect updates to this manual over the next few months  

 
 
Do NOT read this entire manual… unless you want to.   

• At the start of Chapters 1 - 4 are short sections with references to find what you need plus some important 
reminders.  PLEASE read these short sections at the very least and refer back to them, when needed. 

• Chapters 1 and 2 are very important in terms of correctly setting up your Skycut to work with SignMaster 
and learning the ins and outs of cutting. 

• Chapter 3 is for those owners wanting to perform print and cut applications. 

• Chapter 4 covers using Skycut accessory tools and dual head applications. 

• Chapter 5 covers several SignMaster functions of interest: creating contour cuts and engraving fills.  

 
It’s not practical to print this entire manual because: 

• It’s a waste of paper and ink if you only ever need certain sections. 

• The live links to videos and web sites in the manual will not work. 

• This manual will be updated from time to time. 

• You cannot search on individual words. 

 
Also: 

• Videos of interest can be found at the following link:  Skycut Support Videos 
 

 

 

________________________________________________________________ 
 © 2018-2021  Sunrise Electronic Technology Co., Ltd.  All Rights Reserved 

https://www.iloveknk.com/support/skycut-videos/
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1. Introduction and Setting Up 
 
 

1.00 Quick Reference for This Chapter 

• How to download and set up SignMaster:  Section 1.11 

• How to set up communication between a computer and Skycut: Section 1.12 

• How to use the control panel: Sections 1.10 and 1.14 

• How to adjust the blade holder: Section 1.07.5 

• Where to position the pinch wheels: Section 1.09 

• The cutting mat is too sticky (or not sticky enough): Section 1.08 

• How to use the USB Flash Drive feature: Section 1.12.4 

 

Important Notes: 

• Please read Section 1.02 regarding safe operation of the Skycut. 

• Report any damage or missing contents to your dealer promptly. 

• Retain the original box and packing materials in case you ever need to ship your Skycut. 

 

 

1.01 Support 

• Thank you for choosing a Skycut digital die cutter. Before using a blade in your new cutter, we urge you to 
read Chapters 1 and 2 and watch the videos linked in these chapters. 

• If you run into difficulties with the operation of your Skycut, turn off the power and look for a solution in this 
manual. Note that Appendix A is a Troubleshooting section.  If you continue to have technical questions or 
issues, please contact your dealer as soon as possible. 

• If anything is missing from your order or you have mechanical issues with your Skycut, please contact your 
dealer as soon as possible. You can also contact Skycut directly using this email address: 
skycut@skycut.cn.  

• For additional information and support with the Skycut, please check out the following: 

 Skycut web site: https://www.skycutcutter.com/ 

 Skycut Facebook page: https://www.facebook.com/skycutcuttingplotter/ 

 Skycut Facebook group: https://www.facebook.com/groups/Skycut 

 Skycut YouTube channel: https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA 

• For SignMaster support, please go to http://signmaster.software/support/ 
 
 
 

1.02 Safety and Warnings 

Please be aware of the following safety guidelines when working with the Skycut: 

• Pinch Points:  Keep hands, long hair, loose clothing, jewelry, etc. away from the moving parts. 

• Risk to Children and Pets:  Please supervise children around the cutter when it is in use.  

• Movement and Touching:  Do not move the Skycut or touch any circuitry while it is plugged in.  

https://www.facebook.com/skycutcuttingplotter/
https://www.facebook.com/groups/Skycut
http://signmaster.software/support/
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• DO NOT touch or jam the plotter’s track while it is operating. If the cutter is damaged, it is the owner’s 
responsibility. 

• DO NOT shake the cutter while it is operating. 

• DO NOT cut any materials that have staples or other embellishments attached. 

• DO NOT touch the cutter with a magnet. It is safe, however, to cut magnetic materials, such as those used 
on refrigerators and car exteriors. 

• DO NOT allow any liquids to spill into the cutter. 

• DO NOT allow small items to fall into the cutter. 

• Place the Skycut on a sturdy and stable table, desk, or trolley. The optional Skycut stand can also be used.  

• Always turn off the Skycut when not in use. Leaving the cutter turned on for extended periods of time can 
possibly damage the machine. 

• Always turn off the Skycut before unplugging or removing the power cable from the wall outlet or power 
strip. 

• Unplug the Skycut from a wall outlet or power strip during an electrical storm or when the cutter will not be 
used for an extended period of time. 

• Transporting: When transporting the cutter, move the pinch wheel lever into the upward position. Remove 
the blade from the blade holder and cover the tip with the plastic cap.  

 
 
 

1.03 Warranty 

• IMPORTANT! If your Skycut is damaged during shipment or appears to be defective, your dealer should be 
notified as soon as possible.  

• For additional information regarding your warranty, please refer to your Skycut dealer.  

• It is recommended that you retain the original box with packing materials in case you ever need to ship your 
Skycut. 

 
 
 
1.04 Unpacking      

• Verify that you have received all contents. There is a checklist in Section 1.05. Please notify your Skycut 
supplier immediately if anything is missing. 

• Remove all packaging before turning on the Skycut. Currently, the cutter ships with two end cap foam 
protectors, zip ties on either side of the blade carriage, and tape on either end of the cutting strip. Be very 
careful when removing the zip ties – it’s best to cut those ties from behind the machine versus in front. 
Gently remove the tape at the ends of the cutting strip by rolling the tape away.  Do not pull straight up. 

• Because the cutting mat must be folded over to fit into the box, it may have become slightly rounded during 
shipping. Gently and only partially roll the mat in the opposite direction to remove the roundness and place 
on a flat table to make sure the mat now lies horizontally to the surface.  Refer to Section 1.08 for additional 
instructions on preparing the mat for use. 

• Use the enclosed test pen as you experiment and become familiar with operating the Skycut. Place scrap 
paper on the mat and simply draw shapes rather than cut them. This will prevent possible damage to the 
blade, mat, and cutting strip as you learn where shapes will cut and the basic operating procedures. 

 
 
 

1.05 Contents    

• Besides the cutter, your box should also contain the following items: 

https://drive.google.com/file/d/1SqKgnfvdcoJmDuzjWTQzgOZQjgZm14O9/view?usp=sharing
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# Description Image Quantity (V model) Quantity (D model)

1 Power cable 1 1

2 USB Cable 1 1

3 60° Blade(blue cap) 1 1

4 45° Blade(red cap) 2 2

5 Blade Holder 1 2

6 Test Pen and 1 Refill 1 set 2 sets

Creasing Tool 0 1

7 Cutting Mat 1 1

 
 

 
 

1.06 Parts of the Skycut      
 

Front 
 
 
 

 
 
 

                      

Alignment Marker 
 Pinch Wheel 

 
Control Panel 

Left  
End Cap 

Right 
End Cap 

Left-Side Blade Holder 
Seat (Left Jaw)  
(D model only) 
 

Blade 
Carriage 

Ruler 

Cutting Strip 
(lt. gray) 

Grit Shaft (dk. 

gray and rough) 
Right-Side Blade Holder 
Seat (Right Jaw)  
 

Front 
Table 

https://drive.google.com/file/d/1O21LvzCx-dw8iR7gcTnpu1LQ_3OYONTf/view?usp=sharing
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• Alignment Markers: indicate to the user the available positions for the pinch wheels 

• Blade Carriage: moves the Blade Holder Seats left and right 

• Blade Holder Seats or Jaws (2 on D models): hold the blade holder, test pen, and other accessories 

• Control Panel: used to change settings, set up Wi-Fi, calibrate camera, cut PLT files, and more 

• Cutting Strip: protects a blade when cutting backed materials without using a cutting mat 

• Front Table (optional): keeps cutting mat supported horizontally 

• Grit Shafts (5 on 24” model): allow the pinch wheels to grip the mat or material so they can be moved in and 
out of the cutter during cutting 

• Pinch Wheels (4 on 24” model): grip the mat or material so that the grit shafts beneath will feed the mat or 
material in and out during cutting 

• Ruler: for measuring and aligning rolled materials 

 
Right Side 

 
 

 
 
 
 

Left Side 
 

 
 
 
 
 
 

Back 

 
 
 
 

 

Reset 
Button USB Flash 

Drive Port 
USB Port 

Pinch Wheel Lever 
(see following Note) 

Pinch wheels 

Back Table 

• USB Flash Drive Port: used to load PLT 
files via control panel for cutting 

• USB Port: option to connect computer to 
Skycut with included USB cable 

• Reset Button: used to reset Skycut’s 
cutting buffer (does not reset calibrations) 

 

• Power Port: plug power cable into this port 

• On/Off Switch: power cutter on or off 
 

On/Off 
Switch 

Power Port 
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1.07 Accessories 

• Go to Chapter 4 for details on using the engraving and scoring tools.  

 

1.07.1 Assembling the Skycut D Stand (optional) 

• If you purchased the optional stand, please refer to this    for detailed instructions on assembling the 
stand and mounting the cutter onto it. 

 
 

1.07.2 Tables (optional) 
 

• The following instructions are for the original table design. If the tables you purchase have brackets that are 

not part of the table, please watch this video:  

• While the two tables attach onto the cutter and do not require any support, you may prefer to not use them, 
especially if you are only cutting rolled materials. However, if you are using the cutting mat, the support they 
provide will keep the mat horizontal, thus reducing the chance of the mat drooping and causing materials to 
separate from the adhesive on the mat.  

• The screws required for attaching are already installed in the Skycut. They will be removed and then, after 
aligning the holes in the table, replaced to securely attach the table.  

• It’s much easier to install if you have a second person available to hold the tables in place while the screws 
are being inserted. It is also helpful to have a flashlight shining on the inside of the tables to better see the 
holes for alignment.   

• The two tables are identical. Start with either the front or the back of the cutter. 

• There are a number of screws mounted on the inside of the end caps. The ones to be removed are the 
second and third from the bottom. They are also the only two with washers: 

 

 

• Pinch Wheels (4 on 24” model): grip the mat or material so that the grit 
shafts beneath will feed the mat or material in and out during cutting 

• Pinch Wheel Lever: raises and lowers the pinch wheels 

• Back Table (optional): keeps cutting mat supported horizontally 
 

Remove these two screws 
from right-side end cap 

Note:  Newer models no 
longer have a single lever.  
 
Each pinch wheel has its own 

lever to raise and lower.  

https://drive.google.com/file/d/16i2e6_f3XqVNit3-Vl9VZ6aDiJ2CL4sw/view?usp=sharing
https://vimeo.com/376972057
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• Align the holes in the sides of the table with the holes in the end caps. Note in the following photos how the 
flat part of the table is on the outside: 

 

                                

 

• Insert the screws previously removed through the aligned holes and screw back into place. Then repeat on 
the other side of the cutter.  

 
 

1.07.3 Test Pen 
 

• The test pen should be used until you are comfortable with the operation of your Skycut and know, with 
certainty, where images will cut. The test pen should arrive pre-assembled. However, if you want to change 
out the insert to the red ink insert, note how the test pen is assembled:  

 
 
 
 
 

1.07.4 Skycut Blades 

• There are three kinds of blades that fit inside the Skycut blade holder:  

 

  Red             Blue        Yellow 

Spring goes over the top of the pen insert 
and stops at a small ridge on the insert 

Remove these two screws 
from left-side end cap 

Flat part is on the outside 

Right side Left side 

These are the screws that are 
inserted through the holes in the 
table and into the end caps 
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 The 450 red capped blade is suited for cutting thinner materials such as paper, all cardstock types, heat 
transfer vinyl, and wall/auto/decal vinyl.  

 The 600 blue capped blade is a much longer blade and is well-suited for cutting thicker materials, such 
as gum paste, craft plastic, craft foam, and rhinestone template material. 

 Sold separately is the 300 yellow capped blade. It is a wide blade and is well suited for cutting fabric, 
felt, and tint. It has been reported that it also works well with cardstock that has been exposed to 
humidity. 

• Note that the red capped blade and blue capped blade have a cutback on the opposing side of the blade 
(right side, in the earlier photo). This reduces the blade offset value and allows for better detailed cutting of 
small shapes.   

• Additionally, there are other tools sold separately, including a stand, flatbed bolt-on tables, an engraving tool 
and a creasing/scoring tool. Details on the engraving tool and creasing tool (included with the D model) are 
covered in Chapter 4. 

 
 

1.07.5  Blade Installation  

• The blade must be carefully inserted into the blade holder.  Do this over a soft surface (e.g. over a hand 
towel. It’s important to protect the fragile blade!  To install, follow the numbered steps as shown: 

  

 

 

 

 

 

 

 

• The Blade Length (also called Blade Exposure) is how much blade is exposed at the bottom of the blade 
holder.  For optimal cutting, you want this length to match the thickness of the material or be just a tiny bit 
longer.  

• When setting the blade length (Step 4 in the prior photo), hold the blade holder up next to the material 
before pressing the material to the mat, so that you can more accurately set the length to match the 
thickness of the material. For really thin materials, like vinyl and thin paper, just the very tip of the blade will 
be protruding from the bottom of the blade holder. In fact, you should just barely be able to feel it with your 
fingertip and not be able to see it very well, if at all. Having the blade fully extended will never result in better 
cutting. In fact, it can cause skewing, tearing of the material, damage to the blade, and damage to the mat 
or cutting strip.  

• A good way to test your blade length is to fold a piece of the material onto itself and then cut a line into the 
material by hand. Press firmly but not too hard, as more force will not determine if the blade is set to the 
right length. If the blade cannot cut through the material, you will need to extend the blade. If the blade cuts 
through the material and cuts into the next layer, you need to retract the blade. If the blade cuts through the 
material but does not cut into the layer below, you have the perfect length.  

 

3. Turn the brass ring 
counterclockwise until 
loosened. 

4. Turn the large ring clockwise or counter 
clockwise to set blade length to match the 
thickness of the material being cut. 

5. Turn the brass ring clockwise 

until locked back in place. 

1. Push in this button 
and hold so that a blade 
can be inserted OR 
removed. 

2. Gently insert non-sharp end 
of the blade into the holder. 
An internal magnet will pull 
the blade inwards. 
 
Then release button on top of 
holder 
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• When conducting a test cut, be sure to check your mat (or the top of a backing sheet) for cut lines after the 
test. You should be able to set the length to get clean cuts but with only fine lines or no lines in the mat or 
backing sheet. If you do see deep cut lines, retract the blade length ~¼ of a turn counterclockwise. Repeat 
your test cut. 

 
 
 
 

1.08 Preparing and Caring for the Cutting Mat 
 

1.08.1 Tips on Using the Cutting Mat 

• Always use a mat to hold the material to be cut unless the material has its own protective backing. For 
example, vinyl and iron-on transfer both come with a layer that you do not cut. Thus, this backing layer 
serves as the carrier for cutting.  Paper and cardstock do not have a backing, thus they must be cut on the 
mat. 

• IMPORTANT!  A new mat may be too sticky if you are cutting certain products. This can cause difficulty in 
removing cut items without tearing. Place an old but clean bath towel over the surface of the mat and press 
with a brayer or rolling pin.  Then pull up. Test the stickiness by pressing the palm of your hand in the middle 
of the mat and lifting. If the mat remains stuck to your hand, repeat until the mat can still be lifted but will 
release. It should only take a few pressings to greatly reduce the stickiness, as tiny (too small to be visible) 
fibers from the towel are added to the surface. 

• Do not leave the pinch wheels in a down position when the Skycut isn’t in use. This warps the plastic 
sooner, shortening the useful life of the cutting mat.  

 
 

1.08.2 Cleaning and Replenishing the Cutting Mat 

• When mats begin to lose their stickiness, they can be washed: 

 Use a mild dishwashing detergent, warm water, and a soft brush to thoroughly clean the surface. You’re 
not trying to scrub the adhesive but just wet the invisible fibers that have been deposited from your 
cutting materials and get them released from the glue. 

o Rinse well, shake off excess water, and place sticky side down onto a bath towel.  

o Thoroughly dry the non-sticky side of the mat with another towel.  

o Pull the mat up and the sticky side should now be dry enough for immediate use. Test by making 
sure the mat will stick to your hand.  

• While washing with soap and water should revive the original adhesive, you can add more adhesive if 
necessary:  

 Virtually any repositionable adhesive may be used on the cutting mat. Some of the popular choices 
include: Krylon Easy Tack, Aleene's Tack It Over and Over (view the video at the start of this section), 
Crafter's Companion Stick and Spray, Zig 2 Way Glue with wide tip, Craft Smart Off 'N On, and Scotch 
Repositionable Craft Stick. There’s another spray adhesive, Scotch Super 77, which does not leave a 
sticky surface but is excellent for stabilizing paper and cardstock.  

 If you are cutting thicker materials, such as oil board or styrene, then you may want to experiment with a 
stronger adhesive and use painter’s tape to secure the material to the mat. If you are cutting thin paper, 
then you may want to experiment with a lighter adhesive.   

Mat 

Material 

 Perfect Length                 Too Long                            Too Short  
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 With most repositionable adhesives, you can control the tackiness based on the amount applied. Thus, 
always add a little bit at a time.  As mentioned above, if you add too much, just apply a layer or two of 
cotton fibers by pressing with a bath towel.  

• Other reported methods for cleaning mats: 

 Use a plastic scraper (an old credit card will suffice) to scrape off any random material pieces remaining 
on the mat after a cut.   

 For finer particles of paper or lint, you can use a lint roller. Tear off a sheet and then press down and pull 
up across the surface of the mat to clean in sections. Baby wipes can accomplish the same task. 

 To completely remove adhesive from the mat, apply Goo Gone, Duck Adhesive Remover, or Avon’s Skin 
So Soft Bath Oil across the surface. Allow a minute to soak in and then scrape off with a sharp metal 
spatula. Repeat, as necessary until the mat is thoroughly clean and no longer sticky. Wash, dry and then 
add any repositionable adhesive.  

• When necessary, the rubber wheels and the grit shafts may be cleaned with isopropyl alcohol or Un-Du. 
Apply the cleaner to a clean lint-free rag and rub the entire wheel and/or grit shaft until free of adhesive.  

 
 
 

1.09 Pinch Wheels 
 

1.09.1 Raising and Lowering 

• The pinch wheels can be raised (for loading the material and/or mat) and lowered (for cutting). Depending 
on when your Skycut was manufactured, the method for this is different. 

 
Newer Model Pinch Wheels 

• If you do NOT have a single pinch lever, press down on an individual lever on a pinch wheel so that it can 
grip the mat or material. Lift up an invididual lever to raise that pinch wheel.  

 

 
Older Model Pinch Wheels 

• If you have a single pinch lever located at the back-right side of the machine, press down on that lever and 
the pinch wheels will be raised. Pull the lever up to lower all pinch wheels so that they can grip the mat or 
the material inserted into the cutter. IMPORTANT:  Always hold the lever while raising and lowering. Never 
allow the lever to pop up on its own as this can put a lot of stress on the two couplers gripping the pinch 
wheel bar in the back.  

• On the single pinch wheel lever models only, there is also a small black lever on each individual pinch 
wheel. When the lever is raised, there is more downward pressure exerted. IMPORTANT: Only push these 
small levers up when an extra tight grip is needed, such as when cutting reflective film or thick chipboard. 
For normal cutting of most materials, it will not be required. 

Pinch wheel is in 
the up position.  
 

Pinch wheel is in 
the down position.  
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1.09.2 Pinch Wheel Locations 

• Note that for a pinch wheel to grip properly, it must be positioned over a grit shaft. To facilitate alignment, 
note the white rectangles positioned along the horizontal bar behind the blade carriage.  Slide the pinch 
wheels along the bar, as needed:  

 

• When using the cutting mat, it is recommended that the material be placed in the middle of the mat and the 
mat placed roughly in the middle of the cutter.  Then use the second and fourth pinch wheel locations for 
two pinch wheels. This keeps the pinch wheels off the material and provides an equal balance while the mat 
moves in and out during cutting: 

 

 

• Note that if your material is very wide, then it is fine to have the pinch wheels over the material. However, 
you may need to be extra careful when removing any cut shapes or waste material in those locations. 

 

 

1.10 Control Panel 

• When you first turn power on the Skycut, after several seconds, the following Main Screen or Home 
Screen will be displayed: 

 

 

Wheels should be centered over grit 
shafts which are directly below the 
white rectangles 

Middle two pinch wheels 
are placed under 2nd 
and 4th white rectangles 
 

Pinch wheels are approx. the 
same distance from the 
outside edges of the cutting 
mat   

Lever is in down 
position. This is 

recommended for 
most cutting. 

 

Lever is in up position. Do 
NOT use this position except 

with certain materials. 

Note:  These two photos 
ONLY apply to the single 
pinch wheel lever model. 
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• Throughout this manual, the functions above will be referenced along with submenus and additional 
screens.  You will also see the following icons at the bottom of many screens. Pressing the one on the left 
will always return you to the Main Screen above.  Pressing the one on the right will return you to the prior 
window/screen. 

 

 
 
 

1.10.1 Set Screen 

• Pressing the Set icon  opens the Set Screen which contains access to many functions and settings. 
Note the general description and section number (if you wish to learn more about that function now):  

 

 

 
 

1.11 Registering and Installing SignMaster 
 

Set up wireless connection to home 
or office network: Section 1.12.2 

Version numbers, software 
selection, reset: Section 1.14.3 

Calibrate and use camera for print 
and cut applications: Chapter 3 

Array setup, Scale, and options for 
display and cutter behavior: Section 
1.14.2 

Set end-of-cut options: Section 
2.06  

Settings for: LED, Units, 
Language, Screensaver, Alarm: 
Section 1.14.2  

Repeat last cut. While cutting, this icon and function changes to Pause.   

Open and cut PLT files from an 
inserted USB flash drive 

Execute a test cut using current 
speed and force settings 

Set the desired speed and force. 

Toggle the speed for moving the head and 
pinch rollers. In slow mode, the icon 

changes to:  

4 arrow keys for moving the 
head left/right and for moving 
the pinch rollers 

Stop and cancel the 

current cut 

Change settings 
Refer to 1.10.1 

Select which head to use 
or select Double Head 

Go back to Main 
Screen/Home Screen 
 

Go back to prior screen   
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1.11.1 Installing from a Download 

• Once you have purchased a registration for SignMaster, the software can be downloaded from the following 
link. It’s important to use this link so that the Skycut will be installed as the cutter of choice. You will need 
your Product Serial Number that was sent to you. Since you’ll also need this number every time you 
update the software, keep this number in a safe place. 

https://signmaster.software/smc.htm 

• Note where the file will be saved on your computer so that you can later browse to that folder and launch the 
.exe file which has been downloaded.   Follow the steps in the following Section 1.11.2, starting with Step 
(4) .  

1.11.2 Installing from a CD 

(1) Remove the CD from the case and insert into the CD ROM drive on your computer. 

(2) The downloaded file is in.exe format, thus ready to launch.  

(3) If Windows Autorun does not initiate a welcome screen, use Explorer to locate and click on the DVD drive 
letter for your computer. Double click on the Welcome file and the following window will open: 

 

(4) Click on Install Software and wait for the installation program to open.  Select the language you prefer: 

 

(5) Read and accept the license agreement: 

 

Click on Install Software 

Select preferred language 
and click on OK 

Read the agreement, click 
on the accept option and 
click on Next 

https://signmaster.software/smc.htm
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(6) Enter the Product Serial Number which should have been sent to you by email when you purchased 
SignMaster. Note that since you will need this same number any time you update the software, keep it in a 
safe place: 

 
 

(7) Read and accept a second license agreement and then verify the destination for installing SignMaster: 

 

 

(8) Select your preferred Units but note that it can easily be switched once the software is open: 

 

 

 

 

 

 

 

 

 

 

Enter the 20-digit PSN 
provided when you 
purchased SignMaster 
and click on Next 

Note where the program 
will be installed and click 
on Next 
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(9) Select SKYCUT D24 (or the model you have purchased) from the drop-down menu: 

 

(10) In the next window, you’ll have the option to create a desktop icon and install a thumbnail previewer. Both 
are recommended.  

 

Select preferred Units 
and click on Next 

Select SKYCUT D24 and 
click on Next 

Select preferred options and click 
on Next 
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(11) At this point, files will be extracted and installed. Wait for the Installation Complete message and click on 
OK: 

 

(12) Then the final Finish message will appear and you can choose to open SignMaster or wait: 

 

• If you run into any issues installing or activating the program, please visit this link: 

http://www.iifuture.net/faq/index.php?action=show&cat=44 

• You may wish to periodically visit the link provided for SignMaster at the beginning of Section 1.11.1 to 
download and install any new updates.  

 
 
 

1.12 Connecting the Skycut to Your Computer      

• Place your Skycut on a sturdy horizontal surface. If using the cutting mat, be sure to allow enough free room 
in both the front and the back for the mat to extend during cutting. 

• Powering On:  

 Plug the power cord into a wall outlet or power strip. Connect the power cord to the Skycut on the left 
side end cap.  

 Turn on the power using the power button that is also on the left side end cap. After several seconds, 
the light inside the Skycut will turn on and the head will do a slight jog. 

• You have four options for sending files and information from your computer to the Skycut:  

 Direct USB using the included USB cable 

 Wi-Fi – adding the Skycut to a home/office network that is also accessed by your computer 

 Wireless Standalone – connecting wirelessly to your computer 

 U_Disk - Exporting PLT files from SignMaster onto a USB flash drive and then loading those files using 
the control panel on the Skycut.  

• Review the information in the following table to understand the differences between these options. Note that 
implementing any of these options does not preclude you from changing to another one, as needed. 

Click on OK 

Click on Finish 

Leave checked if you wish to 
open SignMaster now 

http://www.iifuture.net/faq/index.php?action=show&cat=44
https://www.youtube.com/watch?v=Ax8IGPCtZYk
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Connection Options for the Skycut

Option USB Wireless to Network (Wi-Fi) Wireless Stand-Alone USB Flash Drive

Description The Skycut is connected to the 

computer via a USB cable

The Skycut is wirelessly 

connected to a network router

The Skycut is wirelessly 

connected to the computer.

Files are saved in PLT format 

from SCAL to a USB flash drive

Requirements USB cable (included) Wireless network router and 

knowledge of router's name 

and password

Computer must have wireless 

capability

USB flash drive

Pros Easy to install; Reliable and fast 

form of communication.

Skycut can be located 

anywhere within range of the 

router; Other computers can cut 

to the Skycut

Skycut can be located 

anywhere within range of the 

computer; Other computers can 

cut to the Skycut

Skycut can be located 

anywhere 

Cons Skycut is physically connected 

to the computer; Cannot be 

accessed by other computers 

at the same time

Requires more steps to set up; 

Some routers may require 

setting changes in order to 

work with the Skycut

Computer is now connected to 

the Skycut, thus no wireless 

access to the Internet or to 

other wireless devices

More steps due to saving and 

then loading the file; Cannot 

adjust size and certain cut 

settings once saved
 

• The following sections present what steps are required for each type of connection. If you run into 
connectivity issues, please contact your dealer. 

 
 

1.12.1 USB Connection      

• Plug the small square end of the USB cable into the right end cap of the Skycut D. Plug the USB end into an 
available USB port on your computer. 

• In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, click on the Connection tab. 

• Verify that Skycut D24 (or the model you have purchased) is selected under Current Cutter. If not, select it 
from the drop-down menu. Under Port Type, select Direct USB Port. In the drop-down menu next to USB 
Port, select an option that contains the word “skycut”: 

 

• If a USB Port option cannot be located, verify the connection at both the cutter and on the computer. Once 
connected, click on Done at the bottom of the window and proceed to Section 1.13. 

Should read 
SKYCUT D24 
(or the model 
you have 
purchased) 

Select Direct USB 
Port 

Look for and select an 
option with “skycut” in 
the name 

https://drive.google.com/file/d/1UxFUrBYBX58H3dPOmiACFzGtvnUWGNH8/view?usp=sharing
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1.12.2 Wi-Fi Connection      

• Note: Not all routers have the same signal strength. It’s usually best to connect the Skycut while it is in the 
same room with the router.  Once connectivity is established, you can then experiment to see how far from 
the router the Skycut can be located.  

• What you’ll need: 

 Name of your home/office network 

 The password for your network 

• Carefully complete the following steps:   

(1) On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 

                           

(2) Click on the Scan button and a list of the available networks will appear. Select your home/office 
network and click on Apply. You will then be returned to the Wifi screen: 

                                    

(3) Click on Set and the following screen will open: 

 

 

Click on Scan  

 Click on Wifi  

 

Click on Set  

 

Select your 
network 

 

Click on Apply 

 

https://drive.google.com/file/d/1XPDIMJ5-oiW_Tgzc8S2xUGVE0CGemf-X/view?usp=sharing
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(4) To enter the password, use the following tips if you are unfamiliar with this type of screen: 

 “Rapid tap” multiple times in succession to select a letter. For example, if your network password is 
cts456, then to enter “c”, you would tap three times on “abc” because “c” is the third letter in “abc”.  
Next you would proceed to “stu” and tap two times to enter “t”. Then you would only need to tap on 
“stu” once to enter the letter “s.”  

 To enter numbers, click on “123” to open the number entry screen. 

 For punctuation, click on “#@~“ to open the extra characters screen. 

 To enter upper case letters, click on the up arrow in the lower left part of the screen. 

(5) Once you have the password entered in the display box at the top, click on OK to return to the Wifi 
screen:  

 

(6) Next check the IP Address that will be assigned to the Skycut. The Skycut will automatically pick up the 
first three sets of digits from your router but will continue to display them as shown above. You only 
need to decide if the last set, which should be defaulting to “200”, can be used. Use the “+” or “-“ buttons 
to make any needed changes. 

(7) Click on Apply and wait for several minutes while your router assigns this IP Address to the Skycut. 
Eventually, you will see Connected OK appear: 

 

Delete last 
character 

 

Password will 
display here 

 

Click OK when done 

 

Toggle to switch between 
uppercase and 
lowercase letters 

 

Switch to punctuation 

 

Switch to 
numbers 

 

Default IP Address 
assigned to Skycut 

 

Click on “+” or “-“ buttons to 
change IP Address, if needed 
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(8) If instead of receiving a Connected OK display, you see Password err, again verify the network you 
selected and the password you entered. If you are unable to successfully connect and the Skycut is 
within a few feet of your router, please check your router’s user manual and/or search online for issues 
with your particular router model.  

(9) If you wish to reset and start again, press and hold the Default button for 3 seconds until the button 
turns red. Then click on Scan and repeat from Step 3. 

•  Once you receive the Connected OK display, in SignMaster, click on the Cut, Plot & Engrave Tools icon 

  (6th from the left on the upper middle task bar) and select Vinyl Spooler.  In the window which 
opens, verify that Skycut D24 is selected under Current Cutter. If not, select it from the drop-down menu. 
Under Port Type, select Windows Port. Mark the option for Port and select TCP from the drop-down 
menu: 

  

• Click on Configure and the following window opens: 

Success! Click on Apply 

 
Click on Apply 

 
Wait will be displayed for 

several minutes 

Should read 
SKYCUT D24 
(or the model 
you have 
purchased) 

Select Windows 
Port 

Click on 
Configure 

Select Port 

Select TCP 
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• Change the IP Address to the one you set up on the Skycut control panel. Click on Test. A Port OK 
message should pop up. Click on OK and then click on Apply: 

                       

• The IP Address should now appear in the Vinyl Spooler window: 

 

• Click on Done and proceed to Section 1.13. 

 
 

1.12.3 Wireless Stand-Alone 

• It’s usually best to connect the Skycut while it is next to the wireless computer.  Once connectivity is 
established, you can then experiment to see how far from the computer the Skycut can be located.  

Default IP Address 

 IP Address should 

now be here 

Click on Done 

Click OK 

Click on Apply 

Click on Test 
Change to IP 
Address from 
control panel 



 25 

• There are two situations to consider before getting started. If you are not sure which applies to your Skycut, 
then select B and go to that section first.  

A. The Skycut has never been set up wirelessly to a network. 

B. The Skycut has previously been connected to a wireless network.  

 

A. The Skycut has never been set up wirelessly to a network 

• Power on the Skycut and wait for the light to come on. 

• On your computer, open your list of available networks. In the list, you should see one with this type of name 
format:  HI_LINK_XXXX where “XXXX” can be any alphanumeric combination, such as “92BF” or “08A5”.  

• Select that network and enter the following Network Key when prompted: 12345678. 

• In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, verify that Skycut D24 is selected under 
Current Cutter. If not, select it from the drop-down menu. Under Port Type, select Windows Port. Mark 
the option for Port and choose TCP from the drop-down menu: 

 

• In the prior screenshot, the IP Address is already set to the correct Stand-Alone IP Address: 
192.168.16.254. If this matches what you see, skip the next two steps. Otherwise, click on Configure and 
the following window opens: 

  

• Change the IP Address to 192.168.16.254. Click on Test. A Port OK message should pop up. Click on OK 
and then click on Apply: 

Should read 
SKYCUT D24 
(or the model 
you have 
purchased) 

Select Windows 

Port 

Click on 
Configure 

Select Port 

Check to see if this is 
already set 

Select TCP 

Enter the following 
IP Address  

Click on Test 



 26 

     

• The IP Address should now appear in the Vinyl Spooler window. Click on Done and proceed to Section 
1.13. Remember that your computer will not have access to the Internet or other network devices while in 
Wireless Stand-alone mode. 

 

B. The Skycut has previously been connected to a network 

• On the Skycut’s control panel, select Set   and then select Wifi. The Wifi screen will appear:  
 

                           

• To reset the Skycut so that it will be found as an available network, press and hold the Default button for 3 
seconds. Release and you should see the Apply button now displays Wait. In a minute the Apply should 
return and you can then proceed back to A. The Skycut has never been set up wirelessly to a network  and 
use the same procedure as if the Skycut was never set up on a network. 

 
 

1.12.4 USB Flash Drive      

• With a USB Flash Drive connection, you will normally follow the steps presented in this section. If you are 
new to SignMaster and/or to your Skycut, it is recommended that you go to Section 1.13 now to learn how to 
insert the mat and test pen, adjust settings on the control panel, and set up a test design. Then, when you 
are ready to cut, return to this section.   

• Design or open a file in SignMaster. After making any changes to the design, click on the Cut, Plot & 

Engrave Tools icon   (6th from the left on the upper middle task bar) and select Send to Cutter. The 
following window opens: 

 

 

Click OK 
Click on Apply 

Press and hold 
Default 

 

Click on Wifi  

 

https://drive.google.com/file/d/1nlBtvOxnWdWJy5Tn0QCrIsXkSReWNvI8/view?usp=sharing
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• Click on the Properties button to open the Vinyl Spooler window. The Cut Options tab should 
automatically be selected. Verify that the Pen Tool is selected (assuming this is your first time testing your 
Skycut).  Also verify that the force and speed settings are not marked. At the current time, it is 
recommended that you always do these settings on the Skycut’s control panel, instead: 

 

• IMPORTANT: For initial testing of your Skycut, it is highly recommended that the test pen be used until you 
know, with certainty, where shapes will draw.  

Uncheck all 
three of these 
settings 

Pen drawing: select Pen Tool 
Cutting: select blade type from 
menu  

Pen drawing: 
leave unchecked; 
Cutting: Check 
and enter settings 

Click on Done 

Select Cut 
Options tab 

 

Preview of 
where shape 
will be drawn 
or cut 

Click on Properties to open Vinyl Spooler window 
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• Click on the Connection tab and verify that Skycut D24 is selected under Current Cutter. If not, select it 
from the drop-down menu. Under Port Type, select Windows Port. Mark the option for Port and then 
select U_Disk from the drop-down menu: 

   

 

 

• Click on Done at the bottom of the Vinyl Spooler window and you will be returned to the Send to be Cut 
window. More about the settings on the left side of the window will be covered in Section 2.03. For now, just 
note where your shape will draw relative to the material and how to initiate the exporting of the PLT file: 

 

  

• Insert a USB flash drive into your computer and allow Windows to find it. Note the drive letter assigned by 
Windows. 

• Click on Cut Now and a Save PLT File window opens because earlier you had changed the connection 
type to U_Disk. Browse to locate the USB flash drive you plan to use and name your PLT file: 

 

 

 

 

Note where the 
design will draw 
relative to where the 
test pen is positioned 

Click on Cut Now 

This figure assumes 
blade holder is positioned 
in the lower right corner of 
the material 

Should read SKYCUT 
D24 (or the model you 
have purchased) 

Select Windows 
Port 

Select Port Select U_Disk 

Select Connection tab 
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• After saving the file, eject the flash drive and insert it into the right side of the Skycut. On the control panel, 
select USB and then Open File:  

  

 

(1) Double tap on USB DISK and a screen will open showing any folders and PLT files on the flash drive. 
Double tap a folder to open it, as needed.  Drag the scroll bar on the right to see more files:  

           

 

Drag here to scroll 

 

Double tap here 

 

Press Open File  

Set up repeats, refer to 

Section 1.14.1  

Locate the USB flash 
drive for saving your files 

Enter a file name 

Click on Save 
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(2) Once you have located the PLT file you want to cut, double tap the name. You will be taken back to the 
USB screen and the selected file name will be displayed: 

     

 

(3) If you wish to cut repeats of the file, select Array Set and a screen will open where you can then select 
the number of rows and columns of repeats, along with the spacing between the repeats. Refer to 
Section 1.14.1.  

(4) If your project is a print and cut (aka contour cut) application, please refer to Section 3.08.  

(5) When you are ready to cut, click on Start Cut.   
 
 
 

1.13 Test Draw Shapes 

• New owners tend to be VERY eager to try out their Skycut. It’s important to test your cutter to ensure that 
data is being sent properly from your computer to the cutter. The following steps will allow you to do some 
testing with the pen tool. But note that the following steps are for DRAWING, not cutting.  Before 
inserting the blade holder into your cutter, please read the following Sections 1.07.4, 1.07.5, 2.01, 2.02, and 
2.03. 

• It is also very important to understand where shapes will cut based on various available options in 
SignMaster. This is partially addressed in the next section; complete details are covered in Section 2.02.2. 

• Before setting up a file for testing, if you are new to SignMaster, it is recommended that you watch the 

following introductory video:  

• You have two options when using the test pen:  

 Insert a sheet of paper directly into the cutter. Make sure the paper is past the ruler so that it doesn’t 
catch when feeding the paper forward: 

 

 Or…Place the paper onto the cutting mat and then insert the cutting mat into the cutter:  

Observe how pinch 
wheels are centered with 
white rectangles 

 

Double tap on 
selected file to go 
back to USB screen 

 

Click here and 
cutting will begin 

http://iifuture.org/vmtuts/getVMTut.php?key=smc_full_introduction&r=0
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• Use any of the horizontal markings at the front of the Skycut (such as the ruler) to align the mat so that it’s 
straight. Lift the pinch lever to drop the pinch wheels onto the cutting mat. Most of the mat and the paper 
should now be behind the cutter, not in the front. 

• Before installing the test pen, make sure the pen will write by scribbling on scrap paper. Note that you will 
probably need to remove a tiny bit of wax on the end of the pen nib. Then follow these steps: 

 Loosen the screw on the left-side blade holder seat, which is considered the “default” side. 

 Insert the blade holder allowing it to freely rest on top of the paper.  

 Before tightening the front screw, raise the test pen up a little bit (~ 1/8” or several mm).  You don’t want 
the pen still touching the paper but you also don’t want the pen too high above the paper either. 

 Tighten the front screw to lock in the test pen. Be careful not to push down on the blade holder seat 
while tightening.  

 

 

• The arrow keys on the Skycut’s control panel will always be used to set the origin for cutting: 

 

 

 

Only the front part of the 
mat and material will be 
in the front of the 
machine. 

 

Feed the mat this 
direction into the 
Skycut 

Align the paper along 
one of the grid lines on 
the cutting mat. 

Observe how pinch 
wheels are centered with 
white rectangles 

 

IMPORTANT!  This is NOT the recommended method for loading the blade holder into the cutter. 
This is presented as a quick way to insert the test pen so that it is in a good position for drawing. 
The instructions for inserting the blade holder will be covered in Section 2.01.3. 
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 Click on the buttons or the arrow keys on your keyboard to move the head left or right and the mat in 
and out. The goal is to have the tip of the pen close to the lower right corner of the paper: 

 

          
 

 Once the pen tip is near the lower right corner, you are ready to proceed with the test. 

• The Force and Speed will also be set using the control panel. Press the Speed/Force button  and the 
following window opens where you can set the Speed and Force to the settings shown. Note that you can 
either press the + and – buttons or you can slide the orange bar with your finger or stylus:  

 

 

Move pen tip 
to this corner 
of the paper. 

Move the pen tip 
to this corner of 
the paper 

Feed the mat this 
direction into the 
Skycut 

The middle button can be 
toggled, if needed, so that 
the movement is much 
slower. 

Use these arrows to move 
the mat in and out and 
move the head left and 
right 

Press this green circle so 
that the left head will be 
used 

Change the Force to ~30 

Change the Speed to ~ 8  
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• In SignMaster, on the left side tool panel, press and hold the General Power Shapes icon and, from the 
drop-down menu, select the Arrow option:  

 

• Press and hold the left mouse button and drag the mouse in the Drawing Area to create the arrow shape. 
In this test, it doesn’t matter where you place the arrow on SignMaster’s Drawing Area, as it will be drawn 
at the origin you set on the machine.  

  

• If you wish to resize the arrow, either drag one of the square handles around the selected arrow or, in the 
settings above the Drawing Area, change the Width or Height, if desired: 

 

• At this point, if you plan to export this file to a USB flash drive, rather than cut directly to the Skycut from 
SignMaster, please go to Section 1.12.4 for instructions.  

• After making any changes to the design, click on the Cut, Plot & Engrave Tools icon  and select 
Send to Cutter. The following window opens. More about the settings on the left side of the window will be 
covered in Section 2.03. For now, just note where the shape will cut relative to the material: 

       

Press and hold the 
General Power Shapes 
icon 

 

Select Arrow 

 

Width and Height 

 

Note where design 
will cut relative to 
where the blade 
holder is positioned 

Test pen is positioned in 
the lower right corner of 
the material before 
drawing 
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• Before executing the cut/draw process, the Pen tool will be selected. Click on the Cutter Control tab and 
the following settings will be displayed: 

 

 

• Click on the small icon to left of Passes and the Blade Settings Library opens: 

 

 

 

• To switch to the test pen, click the down arrow to the right of Description and select Pen Tool: 

         

 

• Click on Apply and the Cutter Settings (Tool settings) will update showing a 0.00 setting for Blade Offset 
(more about this setting is covered in Section 2.03.3): 

 

• Click on Cut Now and a confirmation window opens. Answer Yes to proceed, No to cancel: 

Open Blade Settings Library 

Tool settings 

Click on the Cutter Control tab 

Select Pen Tool A test pen image appears 

Pen Tool now 
appears here 

Pen Tool should now appear here 

Blade Offset should now read 0.00 

Click down arrow 



 35 

 

• After selecting Yes, the Skycut will draw the arrow on your paper: 
 

              

• To draw again, return to the cut window and choose a different origin. Practice moving the origin to different 
locations. If you want to have the arrow draw in a Landscape orientation, then mark the Rotate option. You 
will see the arrow rotate in the Preview: 

 

• Cutting with this setting results in the arrow pointing downwards as shown in the prior preview window: 

 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points to the right.  

 

Check Rotate 

Note arrow is 
now rotated 
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• If you want the arrow to draw where you have it located on the Drawing Area in SignMaster’s main screen, 
versus at the origin, then you need to mark the option called Absolute (position) in the same Send to be 
Cut window: 

  

 

 

 

 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points down  

 

Check Absolute (position) 
Arrow will now draw in 
this location 
 

Location of arrow in 
Drawing Area  

Test pen is still positioned in lower right 
corner of material before drawing 
 



 37 

• Set the origin in the lower right corner of the mat’s grid and then place the paper in the correct location on 
the mat to correspond to where the shape is positioned in SignMaster.   Refer to Section 2.02.2 for more 
details on controlling where images will cut. 

 
 
 
 
 
 

1.14 Default Settings To Consider 

• The Skycut’s control panel offers a number of default settings. Some of these may not be important at this 
point in the learning process. So, you may want to skip this section for now but remember that it’s here and 
could provide you some options to improve your experience with the Skycut. 

• Each of the following sections will refer to one of the settings in the Set screen. 
 

1.14.1 Advanced Settings 

• The optional settings in the Advanced Settings screen are: 

 
 

• Array: Tap the Array button to open the Array screen: 

     

 In the above screenshot, the shape sent to the Skycut would cut 3 across and 7 up & down, for a total of 
21 shapes. The spacing between each shape would be 0.20 inches (Note: to use mm instead of inches, 
switch the Units setting. Refer to Section 1.14.2). 

IMPORTANT:  Please read Section 2.01 before cutting! 

Display (X,Y) location of cutting 
head 

Option to change back to 
single head only 

Set up rows & columns of repeats 

Turn on if you want cutting head 
to move to the far right when 
cutter is powered on 

Separate Cut Speed from Up 
Speed  

Option to change directions on 
up/down keys  

Sizing Calibration 
Refer to Section 2.08 

Tap here to turn on Array      

Spacing between left-to-right repeats 

Number of repeats: left to right 

Number of repeats: up & down 

Spacing between up-&-down repeats 

Repeats for a print and cut application 
Refer to Section 3.08     
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• Show Point: When toggled on, the Main Screen displays movement and location output based on the 
position of the cutting head: 

 

 

 Absolute Location displays the current location relative to a “power-on” location of (0,0):  

o X is the left-to-right location 

o Y is the up-&-down location 

o L is the straight-line distance from (0,0) 

 Relative location displays the change in location currently being made as you press the arrow keys: 

o x is the current left-to-right distance moved from X  

o y is the current up-&-down distance moved from Y 

o l is the straight-line distance from the (X,Y) location 

• Up Speed is how fast the blade travels while in the “up” position, such as when it is moving from the origin 
to the location of the first shape to cut or when moving from one cut shape to begin cutting another. When 
turned off, Up Speed will match the SPEED set for cutting. Turning on this setting will change the 
Speed/Force screen to display both speeds, allowing them to have different settings: 

  

                     

• To right power on: With this setting turned on, the cutting head will move to the far right whenever the 
Skycut is powered on.  

As arrow keys are tapped, all locations 
will update 

Absolute Location Relative Location 

Speed control for arrows buttons is 
located here when Show Point is on. 
Press to toggle to slow speed when 

needed:  

Press here to reset 
Relative Location  

Cut Speed 

Up Speed 

Head Selection 

Force  
Force  

Cut and Up 
Speed 

Head Selection 
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• Y Key Mode: This setting controls the movement of the material or cutting mat when using the up and down 
arrows in the Main Screen: 

 

• System Mode is used to select whether or not the dual head options (D model only) are available on the 
main screen: 

 

• Scale is used is used to input the sizing calibration. Refer to Section 2.08.  
 
 

1.14.2 General Settings 

• The optional settings in the General Settings screen are: 

 

 

 

 

 

 

 

Pressing an UP arrow will move 
the material forward  
 
Pressing a DOWN arrow will 
move material towards the back 
of the cutter 

Pressing an UP arrow will move the 
material towards the back of the 
cutter 
 
Pressing a DOWN arrow will move 

material forward 

Normal cutting/drawing with just 
the blade holder or test pen  

Option to use both heads 
 

When enabled, camera will 
only take one photo at each 
registration mark 

Activate command: refer to 
Appendix C 
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• LED set allows you to change the brightness of the light inside the Skycut or even turn it off:  

 

• Screen and alarm has two settings: 

 Screensaver time: Set a black-out time, in minutes, for the control panel  

 Alarm after finish working: When a job is complete, have an alarm sound (five beeps)  

 

 

Drag to change the intensity 
of the light 

Turn off light 

Increase Screensaver time (or 
drag the orange bar) 

Decrease Screensaver time 
(or drag the orange bar) 

Turn on Alarm to beep at end of 
cut  

Select blackout time for 
screens and end-of-cut alarm 

Set preferred lighting intensity 

Select preferred language for 
control panel 

Select inches or millimeters 
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• Unit allows you to choose either inches or mm for settings such as Show Point and the Spacing setting 
under Array.  

 

• Language allows you to choose from eight languages to be used throughout the control panel display 
screens: 

 

1.14.3 Sys Information 

• The Sys Information screen displays information about the Skycut and only has three setting changes 
available:  

 

 This initial screen displays current version numbers.  

 If you ever need to reset your Skycut, press and hold Default All until it turns red. Then wait for the 
button to update to Success! 

 If you ever need to change which software is in use with your Skycut, press and hold SOFT for two 
seconds and release. The following screen will open: 

Press and hold to open 
Software Screen 

Model ID’s and version 
numbers 

BAUD setting based on 
software selected  

Press and hold to reset Skycut 
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 To use a different software program to cut to the Skycut, press inside the appropriate circle. The Baud 
Rate indicator will automatically change if needed.  

 
 

1.15 Maintenance 

Skycut machines do not require any kind of lubrication or routine checks. However, here are a few things to 
keep in mind for successful operation of your cutter: 

• Keep the pinch wheels clean. Depending on the adhesive being used on the cutting mat, it’s possible for the 
pinch wheels to become sticky and pick up small pieces of cardstock or other material being cut. This can 
lead, in some cases, to the mat skewing or ruining materials during subsequent cuts. To clean the pinch 
wheels, use a lint-free cloth and an adhesive remover such as isopropyl alcohol or Un-Du to clean the pinch 
wheels thoroughly. 

• Keep the grit shafts clean. Equally important as the pinch wheels, the grift shafts beneath the cutting mat 
should also be free of adhesive and tiny bits of material. They can be cleaned the same way as the pinch 
wheels. Note: Do not pour cleaner onto a grit shaft. Instead, dab some adhesive remover onto a lint-free 
cloth and then use the damp cloth to clean the shafts.  You can also use tweezers to remove any material or 
adhesive that is stuck to a shaft. 

• Keep the cutting mat clean and sticky. As mentioned in the Section 1.08.2, the cutting mat can be washed 
with soap and water to remove small invisible pieces of material which are reducing the tackiness of the 
cutting mat. After drying, you can add more repositionable adhesive, if needed. 

• Check your blade holder, as needed. If suddenly you cannot get a clean cut, check the blade holder for any 
tiny slivers of material that may have been caught up by the blade and fed up inside the blade holder.  

• If you cut vinyl or other backed materials regularly, you may need to replace the cutting strip at some point. 
You will be able to tell based on seeing deep cuts in the strip and an inconsistency in the cutting. Contact 
your dealer for information on obtaining a replacement. 

 
 
 

1.16 Other Useful Tools and Supplies 

• The following list has items you may or may not need while enjoying your Skycut. These are suggestions 
based on twelve years of collecting information from other cutter owners: 

 Brayer or Rolling Pin: (1) to apply lint from a towel onto an overly sticky mat  (2) to press materials 
evenly onto a mat for cutting 

 Post-It Notes: (1) for setting blade/tool tip height above a material  (2) for draw and cut applications   

Software options 

BAUD setting based on 
software selected  
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 Old Fluffy Bath Towel: (1) to dry a washed mat  (2) to apply an invisible layer of lint onto an overly-
sticky mat 

 Dishwashing Soap: (1) to remove visible and invisible fibers from the mat, thus renewing the adhesive 
(2) to clean the mat well before adding more adhesive 

 Soft Brush: (1) to gently remove waste scraps during the washing of a mat. Refer to Section 1.08.2. 

 Artist Palette Knife: (1) to gently remove cut shapes from a mat  (2) to scrape off small waste pieces 
from a mat  

 Blue Painter’s Tape: (1) to tape around the edges of thicker materials that might slip during cutting 

 Repositionable Adhesives: (1) to add more adhesive to a cutting mat (most any brand or type can be 
used, provided it is repositionable). Refer to Section 1.08.2 for suggestions and instructions. 

 Adhesive Removers: (1) to completely strip a cutting mat of adhesive (2) to disarm adhesive long 
enough to remove large scraps of material that will not peel off 

 Lint-free Cloth: (1) for dusting off your cutter and cleaning pinch wheels and grit shafts 

 Awl or Paper Piercer (or other sharp pointed tool): (1) to pick or lift out a test cut to verify results 

 Stabilizers: A stabilizer is an adhesive material that is applied to the bottom of the material you are 
cutting so that cleaner cuts can be achieved. The stabilizer works in one or more of the following ways – 
(1) provides firmer contact with the cutting mat (2) provides a final layer that does not need to be cut if 
the stabilizer will be removed after cutting (3) prevent some slightly-elastic materials from being 
stretched by the blade.  Recommended stabilizers include freezer paper, Thermo-web Heat n’ Bond, 
and Steam-a-Seam 2. 

 Double-sided Tape: (1) For securing metal tags or charms to the cutting mat for engraving 

 Non-slip Shelf Liner: (1) To place under cardstock and other material when embossing 
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2. Cutting 

 
 
 

2.00 Quick Reference for this Chapter 

• How to properly mount the blade holder: Section 2.01.3 

• How to control which shapes get cut: Section 2.02.1 

• How to control where shapes get cut: Section 2.02.2 

• Understanding Blade Offset and Overcut: Section 2.03.3 and Section 2.03.4 

• How to set a very precise origin: Section 2.05.1 

• How to add weeding lines to a cut: Section 2.06.3 

• Checklist before cutting: Section 2.07 

• How to get shapes to cut to precise dimensions: Section 2.08 

• How to know which settings to adjust to solve cutting issues: Section 2.09 

 

The Most Common New Owner Mistakes: 

• Too much blade is exposed on the blade holder (material is lifting up and/or tearing) - refer back to Section 
1.07.5 

• The blade holder or test pen haven’t been properly mounted - refer to Section 2.01.3 

• The pinch wheels are not properly positioned (material or mat is sliding around or bunching up during the 
cut) – refer back to Section 1.09 

• Failing to do a test cut (recommended cut settings are not working) – refer to Section 2.01.5 and 2.09 

• Not practicing enough with the test pen and paper (shapes are not cutting in the correct locations) – refer to 
Section 2.02.2 

 
 

2.01 What You Need to Understand About Cutting 
 

2.01.1 You Have To Make Mistakes 

• The key to becoming successful at cutting is to do a lot of it. Those who shy away from using their Skycut 
will never get to the stage of mastering it.  It’s very normal for new owners to be intimidated by their cutter, 
so remember the following key things: 

 You won’t break your new Skycut by cutting paper, vinyl, cardstock, and other easy-to-cut materials.  
The worst thing that might possibly happen is that you’ll break a blade. That’s it!  And the likelihood of 
even that happening is low. 

 You need to start cutting so that you’ll begin making mistakes! It’s in making these mistakes that you 
start to learn. You realize that these mistakes didn’t result in a broken cutter.  Plus, you’ll stop making 
the same mistakes as you remember more of the things you need to check before every cut.  

 As you make fewer mistakes you begin to build confidence and you begin to have more cutting success. 
From there, you begin to experiment more and produce more. Thus, your best course of action is to just 
start cutting… a lot! But first, read the rest of this chapter. 

 
 
 
 

IMPORTANT:  Please read all of 2.01!!! 
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2.01.2 Record Your Successes 

• As you have successful cuts, take note of the settings you just used, such as Force, Speed, blade type, 
number of passes, brand of material, etc. There is a blank form in Section 2.10 that you can print and use to 
record your results.  There are also suggested settings for common materials at the end of this chapter. Use 
these as starting guides but remember that your results may vary based on the many factors which can 
affect cutting. 

 

2.01.3 Installing the Blade Holder, Test Pen, or Accessory Tools    

• The gold blade holder has a rim around the outside that will, when cutting most materials, rest on the silver 
part of the blade holder seat.  When inserting the blade holder, loosen the front screw and then grasp the 
top and the bottom of the black piece and move back a bit while inserting the blade holder. The blade holder 
should then drop down so that the rim is below the black top piece of the blade holder seat: 

 

• The Blade Height is the distance from the tip of the blade to the top of the material you are about to cut. 
Thus, in the photo above, you can see that there are several millimeters of Blade Height which is important 
for two reasons: 

 You do not want the blade dragging across the material when the blade holder is moving from the origin 
to the first shape to cut (or between shapes). 

 More force is applied when there is a drop distance for the blade holder to start cutting. This is also 
referred to as “punch room” and provides more consistent cutting across the width of the machine.  

• When cutting a very thick material, such as 2 mm craft foam, it is recommended that the rim on the blade 
holder be resting on top of the black piece: 

 

• When using the test pen or an accessory tool without a rim, you’ll need to insert the tool using a spacer on 
top of the material.  A stack of 35 Post-It notes or 35 sheets of regular copy paper work well.   

 The recommended method for loading the test pen or another accessory: 

o Place the spacer on top of the material, with the material loaded into the Skycut.  

o Loosen the screw on the blade holder seat and insert the tool so that the tip of the tool is touching 
the top of the spacer: 

Rim of blade holder is resting 
on the silver part of the blade 
holder seat 
 

With the front screw loose, the 
black piece can be moved 
back just a little bit to allow 
the blade holder to drop 
down. 
 

Rim of blade holder is resting 
on the black part of the blade 
holder seat 
 

IMPORTANT:  Only install 
this way when cutting very 
thick materials! 
 



 46 

 

o Now tighten the front screw carefully making sure you are NOT pushing down on the blade holder 
seat. Once tight, remove the spacer.  You should feel the tool gently scratching the top of the 
spacer. 

o This distance will provide the tool some “punch room” to give extra force and more consistent 
results.    

 
 

2.01.4 Adjust the Speed, Force, and Number of Passes Based on the Material and Shapes 

• Using correct cut settings is equally important as the type of blade, blade length, and blade height. Refer to 
Section 2.03 for details about each setting.  

 
 

2.01.5 Perform Test Cuts! 

• You have two options: 

(1) Perform the built-in test cut on the Skycut itself using the Test option on the Main Screen or from within 
the Speed/Force Screen. 

(2) Select any basic shape and size it to be around 0.3” – 0.5” (~ 8 mm – 13 mm): 

o I personally like using a design with an internal shape, such as a ring. You can then easily see if the 
blade is cutting into the mat (or into the backing sheet on rolled materials) when you lift out the cut 
shape and observe where the internal shape cut. To locate a ring, click on the General Power 

Shapes icon  on the left side Tool Panel and go to Basic Shapes>Basic.  

o When cutting intricate shapes, use a small letter or a shape will lots of sharp turns for testing. For a 
rhinestone project, use a small portion of your rhinestone pattern as a test. 

• There is a flow chart in Section 2.09 which will help you determine which settings to change when test 
cutting a material.  

 

2.01.6 Keep the Cutting Mat Clean and Sticky 

• Press your materials evenly to the mat.  Consider using a brayer both before AND after cutting. Repressing 
the material after cutting can greatly aid in weeding the cut shapes from the waste. 

• When necessary, tape thicker materials to the mat to keep them from slipping during the cut.  

• If you cut a range of materials, you might need more than one mat so that you can use stickier mats for 
certain materials. 

• Refer back to Section 1.08 for information on cleaning the cutting mat and adding more adhesive, 
 
 

Pen tip just touches top 
of spacer 
 

Spacer is on top of material 
which is on top of mat 
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2.01.7 Don’t Get Frustrated, Get Help! 

• Besides having your own Skycut dealer as your first line of contact, there are other resources where you 
can ask questions and get answers. Utilize the resources listed in Section 1.01. 

 
 

2.02 Choices Before Cutting 

• There are a number of factors under your control for cutting: 

 What shapes to send to the cutter: Section 2.02.1 

 Where the shapes will be cut from the material: Section 2.02.2 

 What tool(s) will be used for cutting (or drawing, scoring, engraving, etc.): Section 2.02.3 

 What settings will be used: Section 2.02.4 
 
 

2.02.1 Controlling Which Shapes Will Cut 

• There are three ways to control whether a shape will be cut or ignored. In explaining these options, the 
following shapes have been added to the Drawing Area. Note that this file (called Controlling What Cuts) is 
shared in a zip file available here.  

 

 Option 1: If no shapes are pre-selected, then all shapes will be sent to cut. However, if you pre-select, 
for example, only the “Skycut” and the arrow, then only those shapes will appear in the Send to be Cut 
Preview: 

        

o A more common practice is to select all objects of one color and only have those shapes sent to cut. 
To do this, go to Edit>Select by>Color (or use the shortcut key “S”) and the following window will 
open where you can, for example, mark Red to be selected. Then the Preview will only have 
“Skycut”, the red circle, and the red star present: 

 

 

These two 
shapes are 
selected 

Only those two 
shapes appear in 
Preview 

https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view
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o Along the same lines, you can select all objects of type and only have those shapes sent to cut. To 
do this, go to Edit>Select by>Object Type (or use the shortcut key “O”) and the following window 
will open where you can, for example, mark Circle and Star. Then the Preview will only have 
circles and the stars present: 

        

 

o Note that the icon at the top of the screen:  will open a menu where you can then access the 
same Select by Color or Select by Type options: 

 

 Option 2: Mark shapes not to be cut on the Objects tab of the Page Thumbnail Viewer:  

o To access the Objects tab, click on the small icon to the left of the palette: 

Mark the box 
by Red 

Only the red 
shapes appear in 
Preview 

It’s also noted here that 
only red shapes are 
selected 

Click on OK 

Mark boxes for 
circles and stars 

Only the circles 
and stars appear 
in Preview 

Click on OK 

Click on the Select by icon 
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`      

 

o Select a shape, such as the arrow. On the Object tab, it can then be set not to cut: 

 

 

                            

 

 

 

Click this blue 
arrow 

Click the Objects tab 

All of the shapes 
appear in a list 

Arrow is 
selected 

Arrow will not cut Click this icon to 
turn off cutting 

Arrow is no longer in Preview 
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 Option 3: Cutting can be controlled by color from within the Send to be Cut window. Click on the 
Separate by Color option and a drop-down menu will appear: 

  
 

o In the Preview window, shapes with the current color from the menu appear. Also, the color is 
selected at the top: 

  
 

o Switching to blue changes the window accordingly: 

  

o Note that you can also change colors by clicking on those colored rectangles above the preview. 

Drop-down menu 
of colors used in 
the project 

Mark the 
Separate by 
Color option 

Black is selected 
in the drop-down 
menu 

  Black is outlined here 

The one black object is the 
only shape shown in the 
Preview 

Blue is selected 
in the drop-down 
menu 

  Blue is now outlined 

The two blue objects now 
appear in the Preview 
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 Option 4: Select the colors in the Vinyl Spooler window.  

o In the Send to be Cut window, again click on the Separate by Color option. Then, click on Spool 
All:   

 

  
 

o In the Vinyl Spooler window, the job will appear at the top and queueing of each color will begin. In 
this example, Red is at the top of the menu and the red shapes appear in the Preview. Click on Cut 
Now to cut those shapes. Otherwise, click on either Blue or Black: 

 
 
 
 

Click on Spool All 

Enable Separate 
by Color 

Red is queued up 
to cut first. Either 

cut the red shapes 
or select another 

color. 

Click on Cut Now to 
proceed with cutting 
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o After the red shapes are cut, it will no longer be in the menu. The next color (Blue) will be selected 
and you can again choose to cut that color or select the third color (Green):  

 

o After the last color is completed, the job is moved to the Done folder and can be repeated at any 
time: 

 
 
 

 

2.02.2 Controlling Where Shapes Will Cut 

• This was briefly covered in Section 1.13 where the Rotate and the Absolute (position) options were 
introduced.  

 Default: Moves the shapes to align with the origin you have set based on the blade tip. 

 Absolute (position): Cuts the shapes where they are positioned on the Drawing Area.  

 Print and Cut (aka Contour Cutting): Cuts the shapes relative to where registration marks are 
scanned: 

o This is the mode used when you want to print images on your printer and then have the Skycut cut 
them out.  

o Registration marks are printed, along with your images. The printout is placed into the Skycut and a 
built-in camera automatically locates and aligns with each printed mark. The Skycut will then cut out 
your shapes based on triangulation. This is far more precise than Absolute (position) because it 
takes into account not only any misalignment of your printout in the cutter, but also any errors in the 
printing. Most printers do not print images precisely in the location on the paper as they are located 
on the screen. 

Blue is queued for 
cutting. Or select 
Black, if desired. 
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o Note that raster images (.JPG, .BMP, .PNG etc.) will need to be traced first so that cut lines are 
created.  Section 3.04 will present an example.  

o Refer to Chapter 3 for complete instructions on calibrating the camera and examples of PNC 
applications.  

• You can also rotate a design for cutting, relative to how it appears on the Drawing Area: 

 To rotate the project, go to Send to be Cut and mark the Rotate option: 

  

 For example, in a project with long text, it is more convenient to view and edit the text in a left-to-right 
orientation: 

 

 However, when you then send this project to the Preview window, you will observe that it is too wide to 
cut from left to right on your Skycut: 

         

 Marking the option for Rotate will then rotate the design and allow the project to cut: 

The red lines and dimensions 
also indicate the project 
cannot be cut 

Project is too wide to 
cut left-to-right 
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2.02.3 Selecting the Tool to be Used for Cutting 

• To select the tool you’ll be using, open the Send to be Cut window and click on the Open Blade Settings 
Library icon:   

 

• The Blade Settings Library window will open. Click on the down arrow to the right of Description where 
you can access a drop-down menu for the Blade Type: 

 

 

 

 

 

The black lines and dimensions 
indicate the project can now be cut 

Rotated project will now fit 
within the width of the machine 

Click on this icon 
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• Selecting one of the options, such as 45 degree blade will display an image of the blade, the Blade Offset 
and Overcut assigned as a Preset: 

   

• Sections 2.03.3 and 2.03.4 will explain Blade Offset and Overcut settings. Section 2.04 will explain how to 
modify these settings, if needed and save as a Preset. 

       

2.02.4 Determining the Cut Settings  

• There are three locations in SignMaster where Cut Settings can be selected: 

 Send to be Cut>Cutter Control tab (which was covered in Section 1.13) 

 Send to be Cut>General tab  

 Vinyl Spooler>Cut Options tab  

• Send to be Cut>General 

 Use this location when you need to assign different settings to different layers of your project. For 
example, let’s say you wanted to use the embossing tool to score lines in a popup card, followed by 
cutting out the card itself. Or, another example would be using the test pen to draw a design and then 
cutting a contour around it. Under General Options, Assign Tools by Color is marked and then, below 
that in the Cutting Tool Presets section, individual colors can be highlighted and cut settings assigned 
by selecting a Preset or by clicking on Edit: 

 

 

Click here 

Tool menu 

Color of cap on a 
Skycut 45 degree 
blade 

Presets for Blade Offset 
and Overcut 
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 More details for using this feature are covered in Sections 4.01.1 and 4.02.2.  

• Vinyl Spooler>Cut Options 

 Use this option as an alternative to entering settings via the Cutter Control tab. It can be accessed from 
the Properties button in the Send to be Cut window. You will also use it in print and cut (contour cut) 
applications to check and adjust cut settings as well.  

  

 In the Vinyl Spooler window, click on the Cut Options tab and the cut settings are located in the lower 
section of that window: 

  

• These settings should be understood thoroughly, as you will be adjusting them often as you change 
materials or as your blade dulls over time. Note the prior screenshot shows the section number to go to for 
more information. 

Section 2.03.2 

Section 2.03.4 

Section 2.03.3  

Section 2.03.1 

Click Properties to open 
Vinyl Spooler window 

Mark Assign Tools by Color 

A color is selected 

A Preset is selected or settings 
can be entered by clicking on Edit 
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• IMPORTANT: At the time of this writing, Travel Speed defaults to the Up Speed on the control panel. Thus, 
this setting cannot be changed from within SignMaster. Additionally, both the Cut Speed and the Travel 
Speed will default to the values on the control panel when Tool 1 (right side) is selected. Therefore, it is 
highly recommended that all settings be made on the control panel, at this time. 

 
 
 

2.03 Cut Settings 

• Before presenting the various settings, note that the Force and Speed settings can be set on the control 
panel itself. In order to cut from SignMaster and use the settings on the Skycut, uncheck these boxes in 
either of the two places where the settings can be made: 

 Send to be Cut>Cutter Control window: 

 

 Vinyl Spooler>Cut Options window: 

 
 

2.03.1 Force 

• Force (also called Pressure) ranges from 30 to 160 where the maximum of 160 represents ~2000g of 
cutting force. If it is set too low, the material cannot be cut. In fact, it is recommended that the minimum 
setting is always 30 or higher.  However, if it is set too high, you will get bad cutting (even incomplete cutting 
at times) and tearing of the material. Always perform small test cuts before cutting your actual project and 
make adjustments in order to get a clean test cut before proceeding with your larger cut. 

• Dull blades will need more force than new blades, thus anticipate increasing the force over the life of the 
blade. 

• When cutting materials that can use either blade, the 45o blade (red cap) will need a little more force than 
the 60o blade (blue cap), because of the extra contact with the material being cut and because the 60o blade 
is cut much thinner, making it a “sliver blade.” 

• As noted earlier, this setting can be made on the Skycut control panel instead. Press the Force/Speed icon 

 and then set the FORCE to the desired level. 
 
 

2.03.2 Cut Speed and Up Speed 

• Cut Speed (also called Down Speed) is how fast the blade travels while it is in the “down” or cutting 
position. Up Speed (also called Travel Speed) is how fast the blade travels while in the “up” position, such 
as when it is moving from the origin to the location of the first shape to cut or when moving from one cut 
shape to begin cutting another.  

• The Skycut has 13 speed settings ranging from “snail’s pace slow” to “insanely fast.”  

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 
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 The settings from 1 through 4 are the slow speeds and should be used when cutting dense difficult 
materials, such as chipboard, craft plastic, styrene, and balsa. 

 The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such 
as cardstock, vinyl, iron-on transfer, and rhinestone template material. 

 The settings from 9 through 12 are the fast speeds and are useful for engraving, embossing, and 
drawing.  You may, however, find that some materials will cut well at the faster speeds. 

• Cut Speed is usually more important to control since the blade may need more contact time with a 
particular material. Up Speed can usually be left quite high although, for print and cut accuracy, it may need 
to be lowered if there are many shapes to be cut from a printout.  

• On the Skycut control panel, the default setting is to have the Up Speed and Cut Speed the same and 

referred to as SPEED. This can be adjusted by pressing the Force/Speed icon  and then setting the 
SPEED to the desired level.  In order to enter a separate Up Speed on the control panel, refer to Section 
1.14.1. 

 
 

2.03.3 Blade Offset 

• Blade Offset is the horizontal distance from the center of the blade shaft to the tip of the blade.  A pen or 
engraving tool has an offset of 0 because the tip is centered with the center of the pen/engraving tool shaft. 
But a blade is different: 

 
  

 
  
 
 
 
 

• If you set the Blade Offset to 0 when cutting with a blade, corners will be rounded. On the other hand, if it is 
set too high, bubbles will be cut on sharp corners: 

  
 
 

 
 
  
 
 
 

• Currently it is recommended that a Blade Offset of between 0.25 – 0.35 be used for each of the three types 
of Skycut blades.  Any time you order new blades, check for the recommended Blade Offset on the 
packaging.  However, it’s not unusual for blades to be slightly off-spec. Based on cutting a rectangle or 
square, increase or decrease the Blade Offset in increments of 0.1 or smaller until the shape has perfectly 
square corners.  

• Alternatively, SignMaster has two built-in Blade Offset calibration routines which can be used to determine 
the best Blade Offset setting for the current blade in use. Here are the steps to access either one: 

 Select the material you want to use for testing, such as vinyl, paper, or cardstock. Note how much 
material will be needed for the test you select and add a few inches to these dimensions: 

o Normal Test: Width: ~9” (354 mm)   Height: ~3.5” (89 mm) 

o Quick Test: Width: ~4.5” (114 mm)   Height: ~1” (25 mm) 

Offset is too low: 
corners are rounded 

Offset is too high: bubbles 
appear at the corners 

Imagine a line 
passing through 
the center of the 
test pen or 
blade 

The Offset is the distance 
between the center of the 
blade holder and the tip of the 
blade. 

There is no 
Offset on a 
pen. 
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 Install the blade you wish to calibrate into the blade holder and mount the blade holder in the Skycut. 
Enter appropriate settings in SignMaster or on the Skycut control panel. Test cut a small shape to make 
sure the settings are correct.  

 Go to the Vinyl Spooler window and select the Calibrations tab. 

 Click on the Blade Offset icon and a new window opens: 

 

  

 

 

 In both tests, the instructions on the screen will guide you on how to enter the best result and then will 
display the recommended Blade Offset to use. This new Blade Offset value will then be updated in the 
cut settings. Instructions on how to add this setting as a Preset are covered in Section 2.04. 

 
 

2.03.4 Overcut 

• Overcut is related to Blade Offset in that it isn’t needed when using a pen, embosser, engraver, and so 
forth, because the tips of those tools are aligned with the center of the tools themselves. However, leaving 
Overcut at 0 when using the blade holder will result in large shapes not quite closing: 

  
 
 
 
                             
                       

• In some cutting programs, Overcut is not a separate setting but rather automatically calculated and applied 
based on the Blade Offset entered. However, in SignMaster, you can enter an actual Overcut setting and 
should do so any time a blade is used.   

• In general, the blade type doesn’t greatly affect the Overcut required. Try using 1.00 mm. In the event you 
cut a large closed shape, like an 8” circle, you may find that you’ll need to increase Overcut to 2.00 mm.  
 
 

2.03.5 Passes 

• The Passes setting causes each individual path to be cut the set number of passes before the blade moves 
to the next path to cut. This is better than just repeating the entire cut as each repeated pass is cut with the 
blade held down throughout the repeated passes, resulting in cleaner cutting. 

• In general, when increasing Passes, the Force setting can be decreased. For example, you may find a 
cardstock that requires a Force of 55 to cut in a single pass will only need a Force of 45 if cutting in two 
passes. 

• Passes is recommended in the following situations: 

 Cutting thicker denser materials, such as chipboard, where multiple passes allow the blade to 
progressively “carve” through the material 

Overcut is too low: 
paths do not close 

1. Select 
Calibration tab 

4. After loading material and 
verifying cut settings on the 
Skycut, click here.  

3. Select either Normal Test 
or Quick Test (note material 
requirements below) 

2. Click on Blade 
Offset icon 
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 Cutting certain fibrous materials, such as fabric, where a second pass will ensure that all of the fibers 
have been cleanly cut 

 Cutting intricate or detailed shapes (such as script titles) from certain materials, such as heavy or 
textured cardstock, where a single pass may leave certain spots not cleanly cut 

 Cutting rhinestone template material where a second pass results in much cleaner weeding of the cut 
circles 

• You will find a Passes setting in the Send to be Cut>Cutter Control window, under the Cutter Control 
tab: 

 

• IMPORTANT:  In the current version of SignMaster Pro, Passes does not work if Assign Tools by Color is 
activated. Therefore, if you have a project requiring separate settings for layers, such as a score and cut 
project, the Passes function on the Skycut’s control panel should be used instead.    

• If you are only using the left side or only the right side, press the USB button on the Main Screen and you 
will see a Passes button in the window which opens: 

 

 Press the Passes button to open the following screen where you can turn on the Passes function and 
enter the desired number of repeats: 

 

Change Passes here 

Press Passes 

Use + and – buttons to enter 
number of Passes 

Mark this option to activate Passes 

NOTE: If your screen does not 
have Passes Set displayed, 
please go to Appendix C for 

activation instructions. 
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• If you are planning to use both heads, make sure Use Double Head is activated on the control panel’s Main 
Screen. If you do not see this option (as shown in the following screenshot), click on Set>Advanced 
settings>System mode and select double. Then, back on the Main Screen, the following options should 
now appear: 

 

 Press the USB button on the Main Screen and you will see a Passes button in the window which 
opens: 

 

 Press the Passes button to open the following screen: 

 

 

Press Passes 

Use + and – buttons to enter 
number of Passes 

With the upper option selected, 
the screen will display Recut 
times: 

Mark this option to activate Passes 

Choose the recut mode based on 
descriptions below  

Select Use Double Head 
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• Recut mode has two options: 

 If the upper option is marked, then the screen shows a setting called Recut times which you set based 
on the number of passes you want both sides to perform. Note that it will execute both sides’ shapes 
before doing additional passes.  

 If the lower option is marked, the screen changes and you can enter different passes for the two heads 
to perform. Note that it will execute the passes on one side before executing the passes on the other 
side: 

 

• IMPORTANT: Currently the Open recut option will default to off whenever the Skycut is first powered on. 
Thus, make a mental note (or, even better, put a Post-It note on your cutter) to turn this option on when 
using multiple passes in dual head operations. 

 
 
 

2.04 Presets 

• Presets allow you to save your settings for a particular blade type or material.  

2.04.1 Saving a Preset for a Blade Type 

• Let’s say you conducted the calibration for Blade Offset in Section 2.03.3 and determined it to be 0.40 for 
your red capped blade. To save this setting as a preset, use the following steps: 

 Go to the Send to be Cut>Cutter Control window and click on the icon to the right of Blade Offset to 
open the Blade Settings Library:  

 

 

 In the Blade Settings Library, click on the + icon to the right of Description and a window will open 
where you can enter the name for your new preset: 

 

Open Blade Settings Library Click on the Cutter Control tab 

Use + and – buttons to enter 
number of Passes for each side 

With the lower option selected, 
the screen will display repeat 
settings for both sides, separately 

Mark this option to activate Passes 

Choose the recut mode based on 
descriptions below  
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 Click on OK and then select which blade type you are using for this new preset Enter the new Blade 
Offset and Overcut values. Then click Update: 

  

 Click on Apply to close the Blade Settings Library. The new preset will now be available for selection 
in the Description menu.  

• If you need to delete a preset, select it from the Description menu and click on the “-“ icon to the right. 

 

2.04.2 Saving a Preset for a Material 

• IMPORTANT: As was noted in Section 2.02.4, Up Speed (aka Travel Speed) is not functional in 
SignMaster and both speed settings do not apply with Tool 1 (right side) applications. Thus, unless using a 
preset with Tool 0 (left side) cutting, it is recommended that presets be made on the control panel.  

• Before proceeding, note the following: 

 Even if you are not using the right side for a particular material, make sure the control panel is set to 
Double under Set>Advanced Settings. Otherwise any presets entered will be automatically assigned 
to the right side.  

 Because settings for any given material or application would need to be entered twice to make those 
settings available for both right and left sides, consider which side you might always choose to use. For 
example, if you always use the left side for cutting and the right side for scoring, then only enter those 
settings for those sides.  

 There’s a maximum of 10 presets allowed, thus consider which materials or applications are most 
important to you. 

• To create a preset: 

 Verify that Use Double Head is selected on the main control panel screen: 

 

 

3. Click on Update 

2. Enter new Blade Offset 
and Overcut values 

1. Select type of blade 

4. Click on Apply 

Enter a new name Click on + 
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 Press the Force/Speed icon  to open the Force/Speed screen: 
 

 

 Make the necessary changes to the SPEED and FORCE settings. Select Save and the following screen 
opens: 

    

 Press one of the unused preset boxes, e.g. name5, and it will turn blue indicating it is highlighted. Select 
Rename.  

 A window opens where you can enter the name for the new Preset. The characters are entered in the 
same manner as the Password entry window in Section 1.12.2.  Note that there is a 15 character limit. 
Click on OK when done: 

Adjust settings by sliding bar 
or using + and - buttons 

Click on Save 

Select which side will 
be used 

Select an 
unused box Select 

Rename 

Mark Use Double Head 
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 You will now see the name of your new preset and you can press Save to add it to the saved presets 
with the FORCE and SPEED you set.  You will be returned to the Force/Speed screen. 

   

 

 

 To verify the preset or to select a different preset, press Preset. The Preset window opens where you 
can see all of the Presets, along with the settings for those presets.  In that window you can also select 
a different preset. Then you can select Rename to edit its name or select Load to select that preset’s 
Force and Speed into the Force/Speed screen. Note that if you need additional Passes when cutting a 
material, they will need to be set using the instructions from Section 2.03.5. 

Delete last 
character 

 

New preset name 
will display here 

 

Click OK when done 

 

Toggle to switch between 
uppercase and 
lowercase letters 

 

Switch to punctuation 

 

Switch to 
numbers 

 

Press Save 

New Preset 
name 
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2.05 Setting the Origin before Cutting 

• Before you cut, you should check to see where the blade tip is located in relation to the material so that the 
shapes will cut in the appropriate location. 

• IMPORTANT! The Skycut D24 has a maximum cutting width of 24 inches. If you move the head too far to 
the left to begin the cut and your project is wide, you may exceed the left side limit and cutting will stop at 
that point with no option but to abort.  

• To set the origin, press the arrow buttons on the main screen of the control panel. Remember that the 
middle button can be toggled between regular speed and a slow speed for more control: 

 

    

• In general, you set the origin near the lower right corner of the material, as you did during your initial test 
drawing in Section 1.13.  

• If you ever choose to have Use R (Head) (P1) selected on the control panel, the origin will be base on the 
right-side tool, verus the normal left side: 

 

Select 
Preset 

Select Rename to 
edit the name 

Select Load to change 
Speed and Force to 
these settings  

Press here to 
toggle origin 
setting speed 
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2.05.1 Setting an Origin Using the Camera 

• In the event you need to set an extremely precise origin, the Skycut’s built-in camera can be used: 

(1) Go to Section 3.03 and perform the camera calibration.  

(2) Choose where you want the origin to be set. You’ll need an “origin target” to use when the camera takes 
a photo. It can be a dot on your material, the corner of your material, the intersection of grid lines on the 
mat, etc. If you do choose the latter, make sure there’s a way to clearly distinguish which intersection 
you want to use. 

(3) Note that whether the right or the left blade holder seat is moved to the origin you set depends on which 
mode you’ve selected on the Control Panel: 

 Use L Head (P0): will align the left blade holder seat  

 Use R Head (P1): will align the right blade holder seat 

 Use Double Head: will align the right blade holder seat (thus, you may need to temporarily switch 
to Use L Head (P0) to set the origin and then switch back to Use Double Head for a dual tool 
application). 

(4) On the Skycut’s Main Screen, use the arrows to move the center of the blade holder roughly over the 
origin target. In this example, a dot will be used. 

(5) Select Set and Camera. In the Camera Screen, press OK. A photo will be taken and displayed. If 
needed, press X3 so that you are zoomed out and able to see the origin target (dot) in the photo: 

 

 

 

 

 

 

 

Press here to switch to right side only. 
 
The origin will now be based on the 
tool mounted on the right side of the 
Skycut D 
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(6) Press the center of the origin target in the photo so that the red + will be moved approximately over it: 

 

 

(7) Press OK. In the new photo, the blue dashed + should be close to the origin target. Press X3 to zoom 
in: 

   

 

(8) Use the arrow buttons to move the red + as close as possible to the center of the origin target: 

Origin Target (dot) 

Red + 

Blue dashed + 
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(9) Press OK. At this point the blue dashed + should be centered with the origin target: 

 

 

(10)  Press the Home icon to return to the Main Screen. The head should move so that the blade holder is 
now located over the origin target and you can proceed with the cutting process. 

 
 
 

2.06 Other Cut Setting Functions  

• There are other functions and features available in the Send to be Cut window that may be useful 
depending on your application. Some have already been covered. Some will be covered in this section. 
Others will be covered in later parts of this manual. Note the section numbers for reference: 

 

Section 3.03 

Section 2.06.1 

Section 2.02.2 

Section 2.02.1 Option 3 

Section 4.01.1 

Section 2.06.3 

Section 2.02.2 

Section 2.06.3 

Section 2.06.3 

Section 2.06.4 

Section 2.06.3 

Section 2.06.2 
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2.06.1 Advance Mode  

• The Advance After Plot option in SignMaster Pro is actually controlled on the Skycut itself. The function 
can be opened by going to Set>Advance Mode on the control panel. 

 

 

 to start will cause the blade holder to return to the origin after cutting. 

 to end will cause the blade holder to advance forward to the end of the cut project. 

 to left will cause the blade holder to move to the left of the cut project. 

 The settings below the option are activated when choosing either to end or to left. You can enter a 
specific distance for the blade holder to advance. This is useful when cutting repeats of the same 
project because it allows for the origin to be set automatically for the next repeated cut. 

 
 

2.06.2 Mirror 

• Checking the Mirror option will apply a horizontal mirror to the shape (s) before cutting. This is useful in 
applications such as: 

 Cutting HTV in which the material is placed faced down so that the heat protection layer is not 
penetrated by the blade 

 Cutting vinyl to be applied to the inside of a car or home window but primarily viewed from outside of the 
window 

 When cutting certain non-homogenous paper materials in which cutting upside down yields cleaner 
results 

   
 
 
 
 

Use “-“ and “+” buttons to 
set an advance amount 

Select from these 
three options 

Before applying Mirror After applying Mirror 



 71 

2.06.3 Weeding Options 
 

• For those cutting vinyl and HTV, the weeding options in SignMaster are worth noting. 

 Auto Weed-Box: Marking this option places a single weed box around the entire project: 

   

 

 

 

o Note: to change the size/offset of the weed box around the design, click on the Settings tab and 
adjust, as desired: 

 

 

 

 

 Auto Speed-Weed: Marking this option places a single weed box around the entire project with an 
additional horizontal weed line through the middle: 

 

   
 
 
 
 
 

 Easy-Lift Weed Marks: Marking this option adds hooked lines to shapes with internal paths to make it 
easier to lift with a weeding tool: 

Before applying Auto Weed-Box After applying Auto Weed-Box – blue 
border around design indicates weed cut 

Change offset here 

Click Settings tab 

Before applying Auto Speed-Weed After applying Auto Speed-Weed – blue weed 
box plus horizonal weed cut in the middle 
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 Speed-Weed Text Only: Mark this option when your design has a combination of both text and other 
shapes so that only the text will have Speed Weed applied: 

    

 

 
 
 

2.06.4 Weld Text 

• For script fonts, the Weld Text option will remove overlap between letters so that a word will cut as one 
object. For example, if you go to View>Wireframe, you can see the overlap that will be cut when a script 
font is used: 

 

• You have the option to select the letters and apply the Weld function under the Shaping and Welding 

Tools , thus removing overlap between letters: 

 

• This, however, means you cannot change the font used or alter the spacing of the letters, etc., without 
applying Undo. Therefore, the Weld Text option allows you to cut the text as if the Weld function has been 
applied: 

Before applying Easy-Lift Weed Marks After applying Easy-Lift Weed Marks – 
hooked cuts are added to internal shapes for 
easy lifting during the weeding process 

Before applying Speed-Weed Text Only After applying Speed-Weed Text Only – 
text object has additional weed box plus 
horizontal cut through the middle 
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2.07 Important Checklist Before You Cut! 

• Do you have your material on the mat and the mat inserted into the Skycut?  (Note: materials with a backing 
sheet, such as vinyl and iron-on transfer do not require a mat for cutting) 

• Have you selected pinch wheels positions that are roughly the same distance from the outside edges of the 
cutting mat (or material, if not using the mat)? 

• Are the pinch wheels in use centered over grit shafts (located below the white rectangle labels)? 

• Do you have the pinch wheel lever raised (so that the pinch wheels are down)? 

• Have you set the blade length/exposure based on the thickness of the material you are cutting? 

• Do you have the blade holder firmly mounted in the blade holder seat and the blade tip at the correct height 
above the material? 

• Have you set the Origin (location of the blade tip) at the bottom right corner of your material (or wherever 
you need the origin to be)? 

• Have you selected the correct mode on the control panel (Left versus Right versus Double Head)? 

• Have you set the Force?    And the Speed?  Do you need to do a test cut? 

• Do you need to turn on Passes for this material? 

• Have you selected the correct Blade Offset for the blade you are using? 

• Do you see the correct shapes in the preview window? 

• Do you need to select Rotate, Mirror or Absolute (Position) options? Do you know, with confidence, where 
your shapes are going to cut? 

• Do you need to apply any weeding options? 

 

 

2.08 Scale Calibration 

• If you were to cut out any particular shape, for example, a 10” x 10” square, you might find that it actually 
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in 
either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore, it 
may not even be necessary to do this particular calibration.  However, if you do want to make sure your 
shapes are cut precisely to scale, the following procedure will allow you to calibrate your Skycut. 

• The calibration process can be conducted in inches, cm, or mm.  Both mm and inches will be presented 
here. In general, it is recommended that mm be used, however, if you do not have a metric ruler, then you 
can use inches instead.  

Before applying Weld Text After applying Weld Text – overlap 
between letters is removed 
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• Before beginning this calibration, make sure the Scale setting on the Skycut itself is still set to 1.0 and 1.0. 
On your Skycut control panel, go to Set>Advanced Settings> Scale. The following window opens where 
you can check the current X Scale and Y Scale values: 

 

 

• Return to the main screen. Then pick one of the two following sections and follow the instructions.  

 

2.08.1 Scale Calibration Using Millimeters for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

 Go to the Vinyl Spooler window and select the Calibration tab.  

 Click on the Cutter Scale icon: 

 

 

 A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 200 mm. Note that in the current version 
of SignMaster, the display in this window is always in inches. However, you can enter values in mm by 
typing in “mm” after the number as shown:  

 

 

 

 

 

 

 

 

1. Select the 
Calibration tab 

2. Click on the Cutter Scale icon 

Verify X Scale and Y Scale 
are both set to 1.0000 

Use the + and – buttons to adjust 
the numbers, if needed  
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 Press the tab key and the 200 mm will be automatically converted into inches. Repeat with Length: 

 
 

 On the Skycut, load a sheet of paper and insert the test pen. Move the test pen to the lower right corner 
of the paper. Make sure you have proper settings for drawing and click on Cut Test to have the shape 
drawn.  

 Using a mm ruler, carefully measure the Width (left-to-right) and the Length (top-to-bottom) that drew:   

Type in 200 mm 
exactly as shown 

Width has been 
converted to in 

Click here to start 
the drawing 

Type in 200 mm 
exactly as shown 
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 Write these measurements onto your sheet: 

 

 These values can now be entered into the same Width and Length fields, again adding “mm” after 
each number as shown: 

         

 

 

 After entering each number, the scaling percentage is automatically calculated: 

 

 

Width, X 
 

Length, Y 
 

Feed the mat this direction 
into the Skycut 

Enter actual Width and 
add “mm” 

Enter actual Length 
and add “mm” 
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 Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

 

 

 Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

2.08.2 Scale Calibration Using Inches for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

 Go to the Vinyl Spooler window and select the Calibration tab. Click on the Cutter Scale icon: 

 

 A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 8 inches:  

 

 

Calculated Scale values 

Click on Update 

Leave this checked for 
each repeated test 

1. Select  the 
Calibration tab 

2. Click on the Cutter Scale icon 
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 Load a sheet of paper and insert the test pen. Move the test pen to the lower right corner of the paper. 
Make sure you have proper settings for drawing and click on Cut Test to have the shape drawn.  

 Using a ruler, carefully measure the Width (left-to-right) and the Height (top-to-bottom) that drew:   

 

 Write these measurements onto your sheet: 

 

Width, X 
 

Height Y 
 

Feed the mat this direction 
into the Skycut 

Enter Width and 
Length to use for test 
shape 

Click here to start the drawing 
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 Convert the measurements to decimals and enter these values into the same Width and Length fields. 
After entering each number, the scaling percentage is automatically calculated: 

            

 

 Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

 

 

 Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

  

Enter actual Width 
and Length 

Calculated Scale 
values 
 

Click on Update 
 

Leave this checked 
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2.09 Test Cutting Flow Chart for the Skycut 
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Scratched the surface; 

did not cut through the 

material.  

Increase force by 10 and 

increase blade exposure by 

~1/4 turn.  

Return to 1.  

There are deep cut 

lines in the mat   

There are no cut lines 

or faint lines. 

If you have an intricate project, you may w ish to repeat using a partia l 

section of the project. Otherwise you are done!  Record your settings!  

Retract the blade a tiny bit.  

Return to 1. 

Cut was clean!  Perform the 

test cut.  

Check cutting 

mat*** for cut 

lines. 

1. 

Partial cut (cut through in some spots 

but not in others)  

Increase force by 10. If you’ve already repeated this 

step several t imes, try sett ing Passes = 2 (or higher 

on dense materials). If doing test cut at control panel, 

change Advance Mode: to Start so that a second 

test cut w ill be in the same locat ion.  

Return to 1.  

Cut was most ly clean but had some 

tearing and/or crumpling  

There are deep cut 

lines in the mat.  

There are no cut lines in 

the mat or faint lines.  

Retract the blade 

~1/8 -1/4 turn.  

Return to 1. 

Try one or more of the follow ing:  

• Decrease the force.  

• Make sure the mat is clean and sticky.  

• Try a different blade in case current 

one is chipped.  

• Dry the material.  

Return to 1. 

Check cutting 

mat*** for cut 

lines.  

A 

B C 

D 

*** or backing sheet, such as with vinyl  

             If a stuttering 

sound occurs during a cut and/

or the mat begins skewing, slow 

down the speed, lower the pres-

sure, and increase the number 

of passes. This will allow the 

blade to work its way through 

the material versus being 

forced.    

• Select a small test shape. You can use the built-in test on the Skycut.  However, a shape w ith an internal path, such as a ring, works better 

as it a llows you to more easily check to see if the blade is cutting into the backing sheet or cutting mat.  

• Start with conservative Force and Speed.  

• Insert the blade holder as instructed in Sect ion 2.01.3 .  

• On the control panel: Set>Advance Mode, choose to End or to Left and enter a small distance, such as 0.5” or 10 mm to space each test.  

• Set origin in the lower right corner of the material.  
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2.10 Settings Form for Cutting Materials 
 
 

Material 
Material Brand or 
Source 

Blade Force Speed  
Blade 
Offset 

# 
Passes 

Other Comments 
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2.11 Suggested Settings for Various Materials 
 
 
IMPORTANT: These settings should be used for the initial test cut only. Adjustments may be necessary based 
on the condition of the blade, variations in the material, humidity, condition of the cutting mat, blade tip height, 
etc. Refer to Section 2.09 for a guide to adjusting settings for optimizing the test cut. 
 
Note: Speed settings are based on the number in parentheses in the Cutter Control tab. 
 

Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Cardstock: light
Light: 65 lb (~176 gsm) 

Recollections
R 1 35 8

Cardstock: medium Medium: Textured Bazzill R 1 40 8 Blade tip ht = 40 Post It notes

Cardstock: heavy
Accent Opaque 270 gsm (100 

lb cover)
R 1 75 5

Chipboard: cereal 

box
 0.018" (0.4 mm) B 1 50 5 Alt: 2 passes at 40

Chipboard 0.022" (0.5 mm) B 2 75 5

Chipboard 0.03" (0.76mm) B 2 95 5

Chipboard 0.06" (1.5mm)
B: left 

R: right

3: on 

both

75: on 

both

1: on 

both

Duplicated image- right side cut / half-blade 

exposure; left side cut at required blade 

exposure; Blade tip ht = 20 Post It notes

Clay
Use a clay press (or pastry 

machine) to make clay thin
B 1 11 10

Make sure pinch wheels will not cross over the 

clay. Blade holder mounted on top of black seat.

Copy Paper Most any brand R 1 30 8

Fabric - Cork embroiderygarden.com B 2 40 5
Blade tip ht = 25 Post It notes; use an extra sticky 

mat and taped around edges. Brayered well.

Faux Leather
~ 1.2 mm thick from Art of 

Fabric Folding (on Etsy)
B 1 50 6

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Faux Leather
AOUXSEEM 1 mm (available 

on Amazon)
B 2 50 8

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Foam - Plain 2 mm B 2 25 10

Foam - Glitter Foamy - 2 mm R 2 15 10

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8

Magnet 0.035" (0.9mm) B 2 50 3 Alt: 1 pass at 85

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8
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Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Tracing Paper Helix Vellum Paper R 1 30 8

Vinyl - Heat Transfer Siser EasySubli - with the mat R 1 30 8 Cut on the mat

Vinyl - Heat Transfer
Siser Glitter - Gold - No cutting 

mat
R 2 35-40 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Heat Transfer
Siser Glitter - Gold - with the 

mat
R 2 45-50 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Wall (no mat) Vinyl - Oracal 631 - yellow R 1 25 8

Vinyl - Wall (on mat) Vinyl - Oracal 631 - yellow R 1 30 8

Vinyl - Waterproof Papilio R 1 30 8
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• The latest updates to these settings can be found at this link. 
  

https://docs.google.com/spreadsheets/d/19oUdlb7VZXsrN0s062wjvpo_C7giT9fIdduq9AGodu4/edit?usp=sharing
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3. Print and Cut (Contour Cut) 
 

 

3.00 Quick Reference for Chapter 3 

• How to calibrate the camera: Section 3.03 (V model), Section 4.01 (D model) 

• How to set up a contour cut: Section 3.04 

• How to add more registration marks: Section 3.08 

• Troubleshooting inaccurate print and cut results: Section 3.06 

• How to set up repeats: Section 3.07 

• How to do a PNC from a USB flash drive file: Section 3.09.1 

• How to use the Array Mark function on the control panel: Section 3.09.2 

• How to include a scoring layer in a print and cut project: Section 4.03.2 
 
 

3.01 What Is a Print and Cut (PNC)? 

• The print and cut process (also called PNC and contour cutting) involves printing an image from SignMaster 
to any printer you own and then, with the aid of the Skycut’s camera, have the image or images cut out with 
perfect precision.  Below are three typical kinds of print and cut applications but there can be other kinds.  

 Cuts along the actual borders of the printed image(s): 

     

 

 Cuts outside of the borders but follows the shape(s) of the printed image(s): 

      

 

 Cuts follow a different shape from that of the printed image(s): 

Image is precisely cut along 
printed borders 

Image is cut in same shape 
but offset from the printed 

borders (contour cut) 

https://www.youtube.com/watch?v=qAq2-6ZEhEQ&t=158s
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3.02 What is a PNC Calibration? 

• In order to get precise PNC results, you must calibrate the camera. This is nothing more than letting the 
Skycut know how far away the camera lens is located relative to the tip of the blade. Because the camera is 
manually installed inside the blade carriage, the distance from the camera’s center to the tip of the blade will 
vary from one Skycut to the next.  

• This calibration only needs to be done one time. If you have travelled with your Skycut or it’s been bumped 
fairly hard, you might want to run a test to make sure your calibration hasn’t changed. It’s also 
recommended that you check your calibration after any firmware updates are installed. 

• The process, which is conducted through the control panel involves: 

(1) Having the Skycut draw a test shape. At that point the camera takes a photo and displays it on the 

control panel, along with a red + and a large blue dashed +. 

(2) Aligning the red + with the center of the test shape display several times until the blue dashed + is 

centered with the test shape. 
 
 

3.03 Camera Calibration Procedure for Skycut V 

IMPORTANT: Please use the following procedure for the Skycut V model. If you own a Skycut D, then calibrate 
the camera using the procedure presented in Section 4.01 as it will calibrate the camera for both the left and 
right heads on the cutter at the same time.  Then you can return to this chapter for more instructions on contour 
cutting applications which apply to both Skycut models. 

• You need the following items for this calibration: 

 Sheet of paper 

 Test pen that came with your Skycut V 

(1) Insert the test pen into the Skycut. Place the sheet of paper into the Skycut. You can use the cutting mat to 
hold the paper or insert the paper directly. 

(2) Move the test pen over the sheet of paper. IMPORTANT: For all camera applications, make sure the 
starting origin is at least 3 inches from the right end cap so that the camera has room to move to the right to 
take a photo. 

(3) Select Speed/Force and set SPEED to ~ 8 and FORCE to ~ 30. Click on Test to verify that a square is 
clearly drawn. If it is too faint, increase FORCE as needed and repeat. 

(4) Move the pen an inch or two away from the test so that there is room for the calibration shape to be drawn. 

(5) On the Main Screen, press Set and then Camera: 

 

 

A custom shape is cut 
around the printed image. 
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(6) Press Adjust to switch to calibrate mode. Press and hold the OK button for several seconds until it and the 
arrows around it turn red (if the buttons do not turn red, please refer to Appendix B1):  

            

(7) Press Start. The test shape, which is a grid of 6 lines, will be drawn on the paper and the camera will move 
over the test shape, take a photo, and display the photo on the control panel. If you cannot see the test 
shape clearly, press the LED button once so that it reads LED 50% and press the Get PIC button. You 
should see three items in the photo: the test shape that was drawn with the pen, a red +, and the blue 
dashed +: 

 

 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  

1. Select Adjust 

2. Press and hold OK 3. Release after 
buttons turn red 4. Press Start 
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(8) Tap your finger near the middle of the drawn test shape. This will move the red + to that location: 

  

(9)  Press OK. A new photo will be taken and one of two things will happen: 

 Situation 1: The red + is so close to the center that the Skycut will now take over and find the true center 
on its own. You will see the red + and the blue dashed + aligned in the center and the arrows (only) will 
return to their blue color. Refer to the left side of the next screenshot. 

 Situation 2: The red + and the blue dashed + are still not aligned and the arrows around the OK button 
are still red. Refer to the right side of the next screenshot.  You will need to tap the center again and 
press OK.  Continue, if needed, until the center is identified. 

                        

Tap your finger here 
 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 

Not quite aligned 
– tap center again  

Everything is 
aligned with 
the center 

versus 

Arrows are 
blue again Arrows are 

still red 

Press Home 

Situation 1 Situation 2 
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(10)  Once the alignment is in place and the arrows have turned blue, press the Home button and then press 
Stop on the Main Screen to save the calibration and conclude the process: 

 
 
 
   

3.04 Performing a PNC in SignMaster  
 

3.04.1 Summary of Steps 

• Here are the typical steps when performing a PNC application: 

 Prepare the image(s) that will be printed which can include the following: 

o An imported raster image such as a JPG or PNG or BMP file 

o A vector image (either imported or designed in SignMaster) that will be printed but not cut 

o Text that will printed but not cut 

 Prepare the cut lines which can include: 

o The resulting cut lines from tracing imported raster files. Refer to Section 5.01 for details on using 
the Trace function in SignMaster. 

o A contour cut around the outside of the traced image: Refer to Section 5.01. 

o Any other vector shapes, either imported or designed in SignMaster: Refer to Section 5.02.  

 Print the project, after selecting reg mark properties, location of project on the page, and printer options.  

 Perform a test cut so that you know the best cut settings to use for the printed material. This test cut can 
often be performed on the printout itself if there is room in the waste area of the project. 

 Perform the cutting process. 

 

3.04.2 Step-by-Step Simple PNC Project 

(1) While it’s not a requirement, it can be helpful in designing if the Drawing Area dimensions match the 

printout size you plan to use.  For this tutorial, Letter size (8.5” x 11”) will be used. But you can use much 

larger sizes, if you have the ability to print in those dimensions.  

(2) To change the Drawing Area, click on the down arrow to open a drop-down menu with many page options 

or just enter the dimensions directly: 

 

 

Press Stop 
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(3) For a sample project, go to this link and download the zip. The project used in this tutorial is called Yellow 

Ox PNC. Alternatively, Section 5.01 presents a tutorial on importing a graphic and adding a contour cut. 

Note the contour cut around this image: 

       

(4) Click on the Contour Cutting icon  and select Contour Cut Wizard. The following window opens: 

           

(5) First, verify that Automatic ARMS is selected which means the camera will automatically scan the 
registration marks.  Registration marks will appear around the image. Next, to verify “what will print” versus 
“what will cut”, click on the other tabs below the preview:  

 

 

 

Click here to open 
menu of page sizes 

Or change the page 
dimensions directly here 

Blue line will be cut 
but not printed 

Yellow and black ox will 
be printed but not cut 

Select Automatic 
ARMS 

Preview of project 
with reg marks 

https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view
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(6) The following options are available for printing:  

 

 Print Direct – Select this option if you are printing directly from this window to your own printer. Note 
that the printer menu and printer properties appear to the right when this option is selected. 

 Print as PDF – Select this option to send the file to Adobe Reader to then print to your printer 

 Save as Image – Select this option to export your printout as a JPG or TIFF file using the DPI resolution 
of your choice  

 Save PDF – Select this option to export your printout as a PDF file to be saved and printed using a 
different computer/printer setup (such as taking to a professional printing company) 

(7) Optional: Before printing, click on the Print Options tab and the project can be centered onto the printout by 

clicking the Center button: 

 

Print-only preview Cut-only preview 

Select the Print 
Options tab 

Click here to 
center the project 
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 The shape is moved to the center: 
 
 

     

 

 

(8) Depending on the print option selected in Step (6), the print button below the Preview will vary. Assuming 

you selected Print Direct, you’ll see the option to Print. Click on it or click on the button in the same 

location and then complete any popup window options as needed. Note that if you’ve already printed your 

project, you will want to click on Skip instead: 

 

(9) Place the printout onto the cutting mat or load the printout directly if a cutting mat isn’t required.  Note that in 

SignMaster, a print and cut project is loaded “upside down” as shown in the following screenshot. On the 

printout is a small arrow which is a reminder to load the printout so that the little arrow is facing towards you 

as you are facing the Skycut:   

 

Before applying Center After applying Center 

Click on Print. Note: the 
wording on this button will 
vary based on print option 
selected in Step (6) Click on Skip if project 

is already printed 

Small arrow should 
point downwards 

Place printout this direction on mat or, 
if no mat is used, this direction as fed 
into Skycut 

Feed this direction into 
Skycut 
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(10)  Load the mat and/or printout so that it is straight, relative to the cutter. The alignment doesn’t need to be 

absolutely perfect but close enough that it will allow for a faster and, of course, successful detection by the 

camera.  Insert the blade holder and perform a test cut, as needed, adjusting the cut settings.  

(11)  Click on the Spooler and the Cut Options tab. If you want to send the cut settings from SignMaster, adjust 

the Force and Speeds accordingly or select a Preset. Otherwise, if using the cut settings on the Skycut 

control panel, turn these off. Click on Done after making any changes: 

 

                 

        

(12)  Back in the Contour Cutting Wizard window, the Print button should now read Cut Now. Click on Cut 
Now and a new Preview window opens which indicates the design should be facing downwards: 

  

Click on Spooler to open the Vinyl Spooler window Make any necessary changes in this window 

Uncheck these options if settings 
on control panel will be used Click on Done to 

close this window 

Printout should be facing this way 

Set blade holder over lower right reg mark 

Click on Next 
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(13)  Click on Next and the Skycut’s camera will now move over each registration mark and take a photo and 
make an adjustment. Once it has read all four marks plus the first one a second time, it will proceed to cut 
out the printed shapes.   

(14)  After testing out this process, be sure to check out other sections to understand additional options, such as: 

 Preparing a vector image for a PNC application – Section 3.05.2 

 Adjusting camera calibration settings, if needed – Section 3.06.1 

 How to set up a grid of repeats – Section 3.07 

 Adding additional registration marks to improve accuracy – Section 3.08 

 Performing a PNC using the USB flash drive – Section 3.09.1 

 Performing a dual head, score and cut PNC – Section 4.03.2 

 

 

3.05 Preparing Designs for PNC Applications 
 

3.05.1 Using Raster Images 

• Use File>Import>File to open a raster image (JPG, BMP, TIFF, PNG, etc) in Signmaster. To add a contour 
cut around this image, there are two options: 

 Add the contour while in the main Signmaster window – this process is covered in Section 5.01. 

 Add the contour after entering the Contour Cut Wizard window by clicking on Build Contours: 

 

o Using Build Contours essentially takes you to the same Create Cut–Contour window and the 
process is the same as presented in Section 5.01. 

• The advantage of tracing images before entering the Contour Cut Wizard window is the abilty to edit the 
tracing and save the file with the tracing in place. An example of editing a trace is covered in Section 5.01.2. 

 

3.05.2 Using Vector Images 

• You can design your own vector images in SignMaster using various design and vectorizing tools. You can 
also directly import vector files in a variety of common file formats including: AI, DXF, EPS, PDF, PLT, and 
SVG.  

• While vector images are essentially ready-to-cut files, SignMaster will not apply them as contour cuts in print 
and cut applications without having them assigned as such. Refer to Section 5.02 for instructions on how to 
perform a contour cut using a vector image. 

 
 
 

3.06 Inaccurate Cuts 

• There are several reasons why your print and cut results may not be as accurate as you need: 

 The contours around the printed image are not accurate 

 The cut settings are too aggressive 

• The following sections present solutions for each of these.  
 

Click here 
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3.06.1 Inaccurate Tracings 

• When tracing imported images, the resulting cut lines may not necessarily follow the original image, 
especially in tight spots.  This can result in tiny bits of white appearing, suggesting the PNC wasn’t accurate.  
Zoom in on the image so that you can see the trace line following the outline of the image. Compare by 
looking at the same spots where the cut didn’t follow the image perfectly. This could be the cause of the 
inaccurate PNC.  There are several ways of handling this situation: 

 Retrace the imported image using a lower Smoothing setting (refer to Section 5.01). This will result in a 
tighter fit around the original graphic. 

 Use the Node EditingTools  to move the trace lines to more closely fit the original graphic. 

 Create an inset contour cut line to use for cutting instead of the original trace line. 

 Create a bleed by choosing Cutting Contour + Bleed in the Create Cut Contour window.  

• Another possibility is that the contour cut line was inadvertently shifted from the graphic to be printed. So, 
check to see if a misalignment may have occurred when you were moving or simply clicking on the design. 

3.06.2 Incorrect Cut Settings 

• If a PNC is not precise and the cause is not the calibration nor the alignment of the trace lines, then go 
through the following check list of other possible causes: 

 Try slowing down the speed.  If the mat is moving numerous times, in and out of the cutter, a slight 
shifting can occur, especially at high speeds. On the Skycut, try a speed of 7 or lower.  

 Verify that the pinch wheels are still centered over grit shafts beneath. 

 Make sure the blade isn’t over-extended which can cause it to cut too deeply and drag the cutting mat. 

 Make sure the bottom of the mat isn’t sticky and the pinch wheels and grit shafts are clean and not 
sticky. Clean with a lint-free cloth and a small amount of isopropyl alcohol or Un-Du. 

 If the print and cut project contains numerous repeats, use additional registration marks so that 
additional scans can occur during the cut.  Refer to Section 3.08 for instructions. 

 
 
 

3.07 Adding Repeats in Print and Cut Applications 

(1) Create a design with the desired contour cut in place. In this tutorial, the same file is used as the one in 
Section 3.04.2, however the design has been resized to ~ 4.5” in height. 

(2) Click on the Contour Cutting icon  and select Contour Cut Wizard: 
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(3) To add repeats, click on the Tiled Copies option and the Quantity settings will appear below that: 

    

(4) As you enter repeats, the Preview will update showing the copies and the overall project dimensions. If you 

need to size the project for a particular printout’s dimensions, mark the option for Print Direct so that you 

can verify whether or not the repeats will fit onto the printout. In this case, trying to fit 4 copies on a single 

Letter-size page will not work: 

 

 

 

 

 

 

 

Click on Tiled Copies 
to add repeats 

Enter rows and 
columns of repeats 

Enter desired spacing 
between repeats 
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(5) In this case, either the spacing needs to be lowered or only two shapes can be used. So, the Spacing is 

decreased and the red margins and dimensions are now black: 

    
    

(6) Note that you have two options that can also be used, at times, to permit more copies to be printed: 

 Reduce the Mark Position setting, which is how far the registration marks are located from the printed 
shapes. More about this option and the Mark Options tab are covered in Section 3.08. 

 Reduce the size of the original by returning to the main window. This, of course, will work in some cases 
but not others. 

 
 

Select Print 
Direct 

Red margins and dimensions indicate project will 
not print with this number of copies 

4 copies 
selected 

Spacing reduced to 0.144 in 

Black margins and dimensions indicate 
project will print  
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3.08 Registration Mark Settings 
 

3.08.1 Adding Intermediate Registration Marks 

• Continuing with the same project from the prior section, to access the registration mark options, click on the 
Mark Options tab in the Contour Cutting Wizard window and note the following: 

 

 

 Set target mark spacing: use this option as a default or if you want to reduce the maximum spacing 
allowed between marks, thus increasing the number of marks. For example, if Vertical Mark Spacing is 
lowered to 100 mm, in this particular case, a new set of intermediary marks are added:  

  

 

 

 Specify number of marks: use this option to force another set of marks to be added: 

Select Mark Options tab 

Space marks based on 
distance 
 

Add more marks 
 

Lower spacing to 100 mm 
 

A new set of marks 
are added 
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• With these intermediate marks added, they will be scanned, as well. Thus, in this example shown, the 
bottom four marks will be scanned and the lower two shapes cut out. Then, the top set of four marks will be 
read and upper two shapes cut out. 

• Note that you can also add intermediate registration marks from the Output Options tab. This is presented 
in the following Section 3.08.2. 

• IMPORTANT: Using the Array plus Array Mark options on the Skycut’s control panel allows for more 
flexibility when working with multiple registration marks, such as being able to only scan one mark when 
there are repeats. This is covered in Section 3.09.2.  

 
 

3.08.2 Registration Mark Types and Sizes 

• The dropdown menu next to Automatic ARMS contains 9 options for the type and size of registration marks 
that can be used: 

 

• There are two shapes available: 

 L - which is the right-angle type mark used in the screenshots so far in this chapter 

 CCD - circular dots 

Change from 1 to 2 
 

A new set of marks 
are added 
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• Note the following size and applications for the individual options in the menu: 

 L-Shape: L marks that are 20 mm x 20 mm in size 

 L-Shape 20x9: L marks that are 20 mm x 20 mm in size. Any intermediate registration marks will be 20 
mm x 9 mm in size: 

 

   
 
 

 L-Shape 9x9: L marks that are 9 mm x 9 mm in size 

 L-Multi: Instead of using the Mark Options tab, intermediate registration marks can be added from the 
dropdown menu. This option will add one set of 20 mm x 9 mm intermediate marks. 

 L-Multi+1: Same as L-Multi, but will add 2 sets of 20 mm & 9 mm marks 

 L-Multi+2: Same as L-Multi, but will add 3 sets of 20 mm & 9 mm marks 

 L-Multi+3: Same as L-Multi, but will add 4 sets of 20 mm & 9 mm marks 

 CCD – 1mm: circular marks that are 1 mm in diameter 

 CCD: circular marks that are 5 mm in diameter 

 
 

3.08.3 Mark Position (Offset Distance from Design) 

• You can also change the offset or distance of the marks from the image. However, you also need to make 
sure marks are not too close to anything printed so that the camera doesn’t incorrectly attempt to scan the 
image instead of a registration mark: 

  

Distance of the marks from the 

outermost shapes 

 

L registration marks CCD registration marks 

L-Shape L-Shape 20x9 
 

Note that the 
intermediate marks 
will print over the 
image!  

The registration 
marks are clear of the 
image  
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• You can see the movement of the marks towards the image as the Mark Position is decreased. Because of 
the shape of the ox, this shouldn’t be an issue with the location of the registration marks relative to the 
printed image. However, if a design is more rectangular, such as a wine bottle label, then it is much easier 
to see that it could cause issues if the Mark Position is too small: 

   

 
 

 
 

3.08.4 Page Marks Option 

• Instead of setting a Mark Position, you can instead use Page Marks to place registration marks inset from 
the printout edges.  

• Enable Page Marks below the Preview in the Contour Cutting Wizard window and the marks will move to 
the outer borders of the page area:  

 

 

 

 

 

 

 

Mark Position = 0.307 in 

Should work 

 

Mark Position = 0.227 in 

 

Mark Position = 0.00 in 

 

Mark Position = 0.557 in 

Will work 

 

Mark Position = 0.057 in 

Will not work 

 

Mark Position = 0.447 in 
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• To change the location of the Page Marks, click on the Print Options tab and under Page Mark Options, 
the distance from the page edges can be changed: 

 
 
 
 
 

3.09 PNC from USB Flash Drive 
 

3.09.1 PNC from Flash Drive – Single Cut 

• To perform a print and cut project from the control panel, first perform Steps (1) – (11) from Section 3.04.2. 
However, before clicking on Done to close the Vinyl Spooler window, click on the Connection tab and 
change the Port to U-Disk from the drop-down menu. Then click on Done: 

 

 

versus 

Mark Position option: 
Reg marks are aligned  

with the project 

Page Marks option:  
Reg marks are aligned with 

the printout edges 

Change left and/or 
top distance from 

page edge 

Change right and/or 
bottom distance from 

page edge 
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• Back in the Contour Cutting Wizard window, proceed as before by clicking on Cut and the same Preview 
window opens and again indicates the design should be facing downwards: 

  

• Click on Next and the following window will open where you can save the job as a PLT file on a USB flash 
drive inserted into a port on your computer: 

 

 

 

Select Connection tab 

 

Select U_Disk 

 

Click on Done 

 

Printout should be facing this way 

Set blade holder over lower right reg mark 

Click on Next 
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• On the Skycut’s control panel, set the Force and Speed, if you elected not to have them activated in the 
Vinyl Spooler window in Step 11 in Section 3.04.2. 

• Go to Set>Camera.  With Align selected, press Set and the following window will open: 

    

 Verify that AutoMark box is checked. Then click on Home. 

• Insert the flash drive into the right side of the Skycut and use the instructions in Section 1.12.3 to open the 
file into the Skycut: 

1. Align should 
be red 

2. Then press Set 

Check 
AutoMark box 

Select the appropriate 
drive 

Name the file Click on Save 
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• Click on Start Cut and the marks will be scanned by the camera and the shapes cut out. 
 
 

3.09.2 PNC from Flash Drive – Using Array Mark for Repeats 

• The Skycut has the ability to set up an array of repeats for PNC applications. The advantage to using the 
Skycut’s control panel for this process is that the Array Mark function permits the scanning of additional 
registration marks as repeats are cut. This is far more accurate than only scanning the original four marks 
on significantly large projects: 

 

• The Array Mark window on the control panel can be opened in two ways: 

• Go to Set>Advanced Settings>Array>Array mark 

• Go to USB>Array Set>Array mark 

• In the Array Mark window, you have three options: 

• 4 Mark: Scan all four marks on every repeat 

 

 

Press Start Cut 

File name should 
appear here 

Reg marks 
printed around 
each repeat 

One set of reg marks 
on a large PNC 
project 
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• 1 Mark: Scan first four marks on first set only. Then scan one mark only on each remaining repeat 

               

 

 

• Alternate:  

       

 

 

                     

 

 

Alternate between scanning all 4 
marks and scanning only 1 
mark, based on a set Interval 

Combination of 4 Mark 

and 1 Mark options 

Interval set to 1: 

1. Four marks in green set are scanned first 
and first three shapes cut. 
 

2. Four marks in orange set scanned, next three 
shapes cut.  
 

3. Four marks in purple set scanned, next three 
shapes cut. 
 

etc. 
 

1. Four marks in green set are scanned first and 
first three shapes cut. 
 

2. Single mark by orange arrow scanned, next 
three shapes cut. 

 

3. Single mark by purple arrow scanned, next 
three shapes cut 

 

etc. 
 

1. 1. Marks in green set scanned and first three shapes cut.  
2.  

3. 2. Single mark by the orange arrow scanned, next three shapes cut.  

4.  

5. 3. Marks in purple set scanned, next three shapes cut. 

6.  

7. 4. Single mark by blue arrow scanned, next three shapes cut. 

8.  

etc. 
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• When choosing an Array Mark option, keep the following in mind:  

• The purpose of having intermediate scans is to correct for any slippage that occurs due to friction or 
excessively fast cutting speed. 

• Use 4 Mark in situations where the repeats are quite large, thus there’s a larger distance between 
the repeats and slippage is more likely to occur. It’s also a good option when cutting thicker 
materials because the higher force applied by the blade can cause more drag on the material or 
cutting mat. 

• Use 1 Mark in situations where the material is thin, the cuts are simple, and the distance between 
the repeats is relatively small. Obviously, this is the most time-efficient choice of the three options 
since a 4-mark scan is only performed one time. 

• Use Alternate as a compromise between the other two options. Experience will determine how high 
of an Interval can still yield the accuracy you need. 

 

 

3.09.3 Mark Set Options 

• The Mark Set window has the following two applications: 

 Select a specific range of images to cut versus the entire project file. 

 While the cutting is underway, if you observe that the accuracy is off, you can immediately pause the 
cutter and tweak the calibration for just that particular cut. 

• To open the Mark Set window, press Mark Set on the USB screen: 

 

 

Interval set to 2: 

1. 1. Marks in green set scanned and first three shapes cut. 

2.  

3. 2. Single mark by orange arrow scanned, next three shapes cut. 

4.  

5. 3. Single mark by purple arrow scanned, next three shapes cut. 

6.  

4. Marks in blue set scanned, next three shapes cut. 

 

etc. 
 

NOTE: If your screen does not 
have Mark Set displayed, please 
go to Appendix C for activation 

instructions. 
 

Press Mark Set 
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• To select a specific range of images, note the following: 

 The first set to cut is referred to as M0 and then subsequent sets are M1, M3, M3, etc. 

 In the Mark Set window, select Custom and then enter the start and ending sets. For example, if you 
want to start with the second set and end with the seventh, you would change to M2 and M7: 

 

     
 
 

 The resulting sets will be sent versus the entire project: 

 
 

• To tweak the calibration after a cut has begun: 

 Press the Pause button on the Home screen to immediately stop the cutting. 

 Press the USB button on the Home screen. 

 Press the Mark Set button. 

 Check or uncheck the adjust Immediately option based on the following: 

o Check the option if you want the adjustment to be made on the current shape that was being cut 
when you paused the Skycut. Note that the start and end point on that path will not completely 
close, as a result. 

o Do not check the option if you want the adjustment to be applied on the next shape that will be cut.  

Select Custom 

Default settings 

Select + and – 
buttons to change 
start and ending sets 

M7 

With M2 and M7 
entered, these sets will 
be cut 

M6 

M5 

M4 

M3 

M2 

M1 

M0 
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 Click on the arrow buttons to adjust the Δx and Δy by the amount and in the direction you need the cut 
line to move: 

    
 
 
 

 Once you have entered the Δx and Δy values you wish to use, press the Go on button and the cutting 
will resume. 

• Important:   

 If you need to make yet another adjustment, repeat the process.  The new Δx and Δy you enter is only 
an adjustment based on what you are now needing. For example, based on this example, if you need Y 
to move another 0.2 mm in the same direction, you would enter 0.2, not 0.4 mm.  

 

 

  

Adjustments to be 
made to cut line 

Click the arrow buttons to move the 
cut line in the direction needed. 
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4. Accessory Tools and Dual Head Calibration 
 
 
 

4.00 Quick Reference for Chapter 4 

IMPORTANT: Note that some of the tutorials in this chapter will be for the Skycut V model while others will be 
for the Skycut D model. The following list indicates which section should be used for one or the other. 
 

• How to calibrate the camera on a Skycut D model: Section 4.01 

• How to draw with the test pen and cut around the drawing: Section 4.02.1 (D model) / Section 4.02.2 (V 
model) 

• How to score and cut a fold-up, print and cut (contour cut) project: Section 4.03.2 

• How to emboss cardstock: Section 4.03.3 

• How to engrave a metal tag: Section 4.04.1 
 
 

4.01 Dual Head Camera Calibration 

• In Section 3.03, the camera calibration was presented for the Skycut V.  The following procedure shows 
how to calibrate the camera for the Skycut D so that both the left and the right heads are calibrated at the 
same time. This then allows you to do accurate draw-and-cut, score-and-cut, engrave-and-cut, and other 
combined tool applications.  

• You need the following items for this calibration: 

 Sheet of paper 

 The 2 test pens that came with your Skycut D 

(1) On the control panel’s Main Screen, make sure the Use Double Head option is selected. If you do not see 
any of these options, click on Set>Advanced settings>System mode and select double. Then, back on 
the Main Screen, the options should now be available: 

 

 

(2) Insert a sheet of paper into the Skycut, either on the cutting mat or directly inserted. Load a test pen into 
both the left and right-side blade holder seats, making sure the pen nib is a tiny bit above the paper, as you 
did in Section 1.13.  You can also use a stack of 35 Post It notes as presented in Section 2.01.3. 

(3) Select the Speed/Force function and make sure both sides are set to a suitable Force for drawing: ~ 30 – 
40.  

Select Use Double Head 
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(4) Make sure both pens are over the paper. IMPORTANT: For all camera applications, make sure the starting 
origin is at least 3 inches from the right end cap so that the camera has room to move to the right to take a 
photo. 

(5) On the Main Screen, select Set>Camera to open the camera calibration screen: 

 

(6) Press Adjust to switch to calibrate mode. Press and hold the OK button for several seconds until it and the 
arrows around it turn red (if the buttons do not turn red, please refer to Appendix B3):  

            

(7) Press Start. The test shape, which is a grid of 6 lines, will be drawn first on the right side of the paper by the 
right-side pen. Then the same test shape will be drawn by the left-side pen about 4 inches to the left of the 
first test shape. 

(8) The camera will move over the right-side test shape, take a photo, and display the photo on the control 
panel. If you cannot see the test shape clearly, press the LED button once so that it reads LED 50% and 
press the Get PIC button. You should see three items in the photo: the test shape that was drawn with the 
right-side pen, a red +, and the blue dashed +: 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  

1. Select Adjust 

2. Press and hold OK 3. Release after 
buttons turn red 4. Press Start 
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(9) Tap your finger near the middle of the drawn test shape on the screen. This will move the red + close to that 
location: 

  

(10)  Press OK.  A new photo will be taken and one of two things will happen: 

 Situation 1: The red + is so close to the center that the Skycut will now take over and find the true center 
on its own. You will see the red + and the blue dashed + aligned in the center and the arrows (only) will 
return to their blue color. Additionally, the camera will now move over to the left side test shape and take 
a photo. 

 Situation 2: The red + and the blue dashed + are still not aligned and the arrows around the OK button 
are still red. You will need to tap the center again and press OK.  Continue, as needed, until the center 
is identified and the camera moves to the left side test shape and takes a photo. 

(11)  Once Situation 1 is achieved and the camera has taken a photo on the left side, tap the center of the test 
shape on the screen and press OK. The camera will take over and locate the center on its own. The arrows 
(only) will turn blue: 

 

 

 

 

 

 

Tap your finger here 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 
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(12)  Once the blue arrows appear, press the Home button and then press Stop on the Main Screen to save 
the calibration and conclude the process: 

 
 
 
 

4.02 Drawing with the Test Pen 

• With the Skycut, you can draw shapes and lettering with the test pen. 

• If you wish to fill (i.e. color in) a shape, select the shape and click on the Plugins icon  and select 
Engraving Module. Refer to Section 5.03 for instructions on how to adjust settings to create a line fill. 

• Do not have the pen positioned too low in the blade holder seat or the tip of the pen could drag across the 
paper when moving from one shape to the next.   Thus, use the 35 Post-It note method presented in Section 
2.01.3. 

• Make sure your shapes will not be drawn where any of the pinch wheels travel over the material. Otherwise, 
the ink might smear.  

 

Press Stop 

Everything is aligned with 
the center 

Arrows are blue again 

Press Home 
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4.02.1 Draw and Cut on the Skycut D 

• A draw-and-cut application involves using the test pen to draw shapes and then using the blade holder to 
cut them out.  This rest of this section covers the process.  

• In the following example, a design is selected from General Clipart and sized for the project. Then a 
contour is added using the instructions in Section 5.01: 

 

• Note that the contour color (blue) differs from the design’s Fill color (black). This is important so that the 
proper left versus right tool assignments can be made. 

• Click on the Cut, Plot, & Engrave Tools icon and select Send to Cutter. In the Send to be Cut window, 
mark the option for Assign Tools by Color. You will then see the two colors, blue and black, appear in the 
Cutting Tool Presets list: 

 

• The layers will be processed in the order shown. However, because it makes more sense to draw first and 
cut second, the blue layer will be moved down. This is done by selecting the blue layer and clicking on the 
down arrow below: 

 

• The tool assignment for each layer needs to be assigned. Click on the drop-down arrow in the Preset 
selection box and the following menu appears: 

Mark this 
option 

Colors used in 
project 

Click the down 
arrow 

Select blue 
layer 
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• Note that Pen Mode (Tool 1)(Head R) is selected since the pen will be mounted on the right side in the 
Skycut. Click on Edit to check for settings that are assigned. Remember that the speed settings need to be 
set on the control panel so uncheck any settings boxes and assign the Force on the control panel, as well: 

 

 

• Repeat the tool assignment for the blue layer, but select Cut Mode (Tool 0)(Head L) from the drop-down 
menu. Then click on the Edit button, verify that the correct blade is selected and, again, no cut settings are 
marked: 

2. Click the down arrow 
to open Presets menu 

1. Select black 
layer 

3. Select Pen Mode 
(Tool 1)(Head R) 

3. Pen Tool should be 
selected 

1. Select black 
layer 

2. Click on 
Edit 

5. Click on Apply 

4. Uncheck all 
Settings 
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• After clicking on Apply, go to the Skycut’s control panel and enter suitable Force and Speed settings for 
both the left side cutting and the right-side drawing: 

        

• Install the blade holder on the left and the test pen on the right.  Set the origin based on the left side blade 
tip and then click on Cut Now in Signmaster.  

3. Select Blade type 

1. Select blue 
layer 

2. Click on 
Edit 

5. Click on Apply 

4. Uncheck all 
Settings 

3. Select right side 1. Select left side 

2. Enter left 
side settings 

4. Enter right 
side settings 
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• The flowers will be drawn with the test pen followed by a contour cut using the blade holder.  

 

 

4.02.2 Draw and Cut on the Skycut V 

• A draw-and-cut application involves using the test pen to draw shapes and then using the blade holder to 
cut them out.  This rest of this section covers the process.  

• In the following example, a design is selected from General Clipart and sized for the project. Then a 
contour is added using the instructions in Section 5.01: 

 

• Note that the contour color (blue) differs from the design’s Fill color (black). This is important so that the 
draw and cut can occur separately, providing the opportunity to change out tools. 

• Click on the Cut, Plot, & Engrave Tools icon and select Send to Cutter. In the Send to be Cut window, 
mark the option for Assign Tools by Color. You will then see the two colors, blue and black, appear in the 
Cutting Tool Presets list: 

 

 

 

 

 

 Click on Cut Now 
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• The layers will be processed in the order shown. However, because it makes more sense to draw first and 
cut second, the blue layer will be moved down. This is done by selecting the blue layer and clicking on the 
down arrow below: 

 

• The cut settings for each layer now need to be assigned. If settings have already been entered and saved 
as Presets, you only need to select from the Preset menu: 

 

• If you need to enter new settings, which will be done for the contour cut (blue) layer, select that layer and 
click on Edit and the following window opens: 

 

Mark this 
option 

Colors used in 
project 

Click the down 
arrow 

Select blue 
layer 

Click the down arrow to 
open Presets menu 

Select black 
layer 

Select Pen Mode 
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 IMPORTANT: Note that this window does not allow you to save the settings as a new Preset. Thus, if 
you will be cutting this material often, you might prefer to set up a preset for it using the instructions in 
Section 2.04.2. 

• After clicking on Apply, you will see that both colors now have settings assigned. Because the blue layer is 
still selected, its settings show along the bottom: 

 

 

• Load the material into the Skycut. Click on Cut Now and you will be prompted to load the Pen Tool: 

 

3. Enter all settings to 
be applied for this cut 

1. Select blue 
layer 

2. Click on 
Edit 

4. Click on Apply 

Blue layer is selected 

Assigned settings 
for blue layer 

Both layers have settings assigned 
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• Load the test pen into the Skycut, click on OK, and the design will begin drawing.  The second prompt 
window will immediately open: 

 

• As soon as the drawing process has ended, load the blade holder into the Skycut and proceed with the 
contour cut by clicking on OK in the prior window. Once completed, click on Done to close the Send to be 
Cut window. 

 

 

This prompt 
window opens 

2. After loading test 
pen, click on OK 

1. Click on Cut Now 
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4.03 Embossing and Scoring 
 

4.03.1 General Info on Embossing 

• The Skycut embossing tool has two different sized embossing heads. The smaller one is recommended 
when scoring cardstock for fold-up projects, such as pop-up cards, gift bags, and small boxes. Either head 
can be used for embossing shapes. 

 

• When embossing cardstock, it is recommended that a soft material be place beneath the paper or cardstock 
to allow a deeper impression to be made. One excellent material to use is non-slip shelf liner.  Other 
materials which can be used include rhinestone rubber, craft foam, and felt. Make sure the material is well 
adhered to the mat (tape it down, if necessary). Then tape your paper or cardstock to the top of this 
material. 

• When using the embossing tool for scoring fold-up projects, the paper or cardstock can be applied directly to 
the mat, just as you do for cutting. This makes it much simpler when you need to score and then 
immediately cut. Because the scoring may not be as deep on the underside of the paper or cardstock as the 
top side, fold all score lines (valley and mountain) forward to establish the fold on both sides. Then flip over 
and fold any mountain folds the opposite way. This especially works well on pop-up cards. 

• Make sure you do some tests first to get the best settings for the scoring or embossing you need.  For 
scoring cardstock, this typically involves a higher force (~75).  If you have a soft material beneath your 
paper/cardstock, then a lower force will be used. As with the test pen, use the 35 Post-It note method 
presented in Section 2.01.3 to install the embosser into the Skycut. 

 

4.03.2 Score and Contour Cut Project on the Skycut D 

• When a project involves both scoring and contour cutting, the layers need to be assigned as such using the 
Custom Fill menu. Otherwise, the Contour Cut Wizard window will only recognize the print layer. This 
section presents the steps required.  

• In this tutorial, a fold up box project will be used as a typical example: 

 

• Click on the Objects tab on the Page Thumbnail Viewer so that you can see the various shapes making 
up this project. In this example, there are two objects making up the score lines, one layer for the printing 
and one layer for the contour cut: 
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• The cut layer and the two score layers need to be assigned as such. Select the blue outline cut layer and 

click on the Custom Fill icon  that is located on the Palette. Select Cut Contour from the drop-down 
menu: 

 

    

 

• Next, click on the first layer of score lines and select Fold Contour in the Custom Fill menu: 

 

 

 

 

 

1. Click this 
blue arrow 

2. Click the Objects 
tab 

Print layer 

Cut layer 

Score layer 

Another score 
layer 

Click here 
 

 
Select Cut Contour 
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• Repeat the last step for the second layer of score lines.  Note that you could also have selected both layers 
at once and assigned to Fold Contour. 

• Go to the Contour Cut Wizard window and verify that the preview windows show the layers have been 
assigned: 

   
   

 

 

• Note that the 8” dimensions in the prior screenshot is red. The settings in the printer properties window need 
to be changed for this project, which is designed for A3 printing. Other settings, such as centering the 
project on the page and choosing the Mark Position should also be done, as presented in Chapter 3. 

Select Fold Contour 
 

 

What will print What will score and cut 
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• Next, assign the left and right sides to the cut and score layers. This is virtually identical to the process that 
was used in Section 4.02.1, other than it is done from within the Contour Cut Wizard window. Click on the 
Print Options tab and arrange the score layer (red) to be carried out before the cut layer (blue): 

 

 

• To assign the Fold Contour layer to the right side, select it, and then click on the drop-down arrow in the 
Presets box. Choose Pen Mode (Tool 1)(Head R) from the menu: 

The previews for printing and for 
scoring/cutting now show the 
dimensions in black and all four 
registration marks in place. 

Select a layer, 
as needed 

 

Use the arrows to 
move that layer 
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• Click on Edit and make sure the cut settings are unchecked as it is recommended that the force and speed 
settings be made on the Skycut control panel. Click on Apply: 

 

 

• Repeat for the Cut Contour layer. Select Cut Mode (Tool 0)(Head L) from the Presets drop-down menu: 

 

 

 

2. Click the down arrow 
to open Presets menu 

1. Select Fold 
Contour 

3. Select Pen Mode 
(Tool 1)(Head R) 

3. Pen Tool should be 
selected 

1. Select Fold 
Contour 

2. Click on 
Edit 

5. Click on Apply 

4. Uncheck all 
Settings 

2. Click the down arrow 
to open Presets menu 

1. Select Cut 
Contour 

3. Select Cut Mode 
(Tool 0)(Head L) 
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• Click on Edit and make sure the correct blade is selected, along with unmarking any cut settings. Click on 
Apply when done: 

           

 

• After clicking on Apply, go to the Skycut’s control panel and enter suitable Force and Speed settings for 
both the left side cutting and the right scoring: 

                         

• Load the blade holder onto the left side and the scorer onto the right side. Print the project using the same 
options and instructions from Chapter 3. Place the printout onto the cutting mat with the printed arrow 
pointed downwards. Proceed with the process by placing the blade tip near the lower right registration mark 
and click on Cut Now. 

• Remove the cut project and fold all score lines forward, as if they were valley folds. Then fold back any 
mountain folds and continue to assemble the project:  

 

  

3. Select Blade type 

1. Select Fold 
Contour 

2. Click on 
Edit 5. Click on Apply 

4. Uncheck all 
Settings 

3. Select right side 1. Select left side 

2. Enter left 
side cut 
settings 

4. Enter right side 
score settings 
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4.03.3 Embossing Paper or Cardstock 

• When embossing paper or cardstock, it is recommended that you use an Outline effect to create several 
very small outlines at a thickness of, say, 0.01” (0.25 mm). These tiny offset lines will then produce a slightly 
thicker overall outline of your shapes. This works better than line-filled embossing which can stress the 
cardstock and cause wrinkling. Here are the steps: 

 Create the shape you wish to emboss. In this example, the number 25 is used: 

 

 Select the shape and click on the Plugins icon  and select Outlining Module. The following 
window opens: 

 

  
 

 After clicking on Accept, use the Objects panel to select the new outline layer and repeat the process 
to add a second outline. Now you have three versions of the shape, each one slightly outset from the 
other.  Thus, when using the embossing tool, this will result in a thicker outline made of this shape.  

 Important: don’t forget to mark the Mirror option in the Send to be Cut window (or apply 
Arrange>Mirror & Rotate>Mirror Horizontally) so that when you flip over the cardstock after 
embossing, the design will “read correctly.”  

 
 

4.04 Scratch Engraving 

• The Skycut engraving tool can be used to engrave vellum, foils, acrylic, and most metals, including trophy 
labels, dog tags, and jewelry charms. 

 

Set Size to 0.01” 

Click on Accept 
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• On softer metals, you may not want the engraving tip too far above the metal as it can leave pock marks 
when it drops to start engraving. If possible, test on scraps first. 

• To design an engraving fill pattern, use the Engraving Module. Refer to Section 5.03  

 

 

4.04.1 Engraving a Metal Tag 
 

• When engraving items that are already cut (such as metal tags, trophy plates, charms, etc.), it’s very 
important to have precise alignment before proceeding.  Therefore, the camera on the Skycut will be used to 
set the origin for engraving. If you haven’t already calibrated the camera, go to Section 3.03. 

• The following is a list of the items you’ll need for this kind of an application: 

 The item to be engraved 

 The Skycut engraving tool 

 Double sided tape to secure the item to the cutting mat. Thermo-web is perfect for this. 

• Create a replica of the item to be engraved: 

 If it’s something simple, like a square or a rectangle, use the basic shapes available in SignMaster: 

          

 If it’s not a shape that can easily be recreated in SignMaster, then trace it onto paper: 

 

 Scan or photograph the trace and use the instructions in Section 5.01 to import the scan and create a 
contour of the heart: 

 

 

 

• IMPORTANT: Carefully measure the actual tag and compare it to the dimensions of the contour. Adjust the 
size of the contour if needed. 

• Create the design. In this case both text and a vector shape of a bone are added: 

Photo of actual tag Replica of tag created 
using two circles 

Imported scan Tracing from Create 
Contour Cut window 

https://www.amazon.com/Therm-Super-Tape-roll-PACK/dp/B00DUGYHN2/ref=sr_1_16?ie=UTF8&qid=1531005087&sr=8-16&keywords=thermoweb+tape
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• Because a filled engraving is desired, select the text and the bone shape and use the Engraving Module to 
fill the design with lines.  Details on this function are presented in Section 5.03.  

 

• To arrange the design in the bottom corner of the Page, click on Snap in the middle taskbar and select 
Page: 

 

• With both the heart and the design selected, drag to the lower right corner until it snaps to the right and 
bottom sides of the Page / Drawing Area (Note: to better illustrate placement on the page and later in the 
Preview, the design has been made much larger. In reality the design is only about an inch in size): 

 

• Select only the design and not the heart tag shape. In the Send to be Cut window, mark the option for 
Absolute (position) so that the design will be positioned the same distance from the origin as it is from the 
corner of the Page / Drawing Area.  Also, verify that Assign Tools by Color is not marked: 

 

 

 

 

 

 

 

 

Mark Page 

Snap the design to the lower 

right corner of the page 
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• On the Cutter Control tab, uncheck Blade Offset as it’s not needed when using the engraving tool: 

 

• On the control panel, click on the Speed/Force icon and enter a Speed of 10 and a Force of 40 for the 
engraving. Note that with your own testing, you may need to alter these settings.  

• The metal tag needs to be very firmly attached to the cutting mat. Place strips of double-sided tape onto the 
mat, where the tag will be mounted: 

 

• When placing the tag onto the mat, align the rightmost side of the tag with a vertical grid line and the 
bottommost side of the tag with a horizontal grid line. The intersection of the two gridlines will be the origin 
for the engraving process: 

 

  

Double sided tape is placed on the 
mat to cover the size of the tag (note: 
the pink liner hasn’t yet been removed 
from the top of the tape) 
 

Align the tag with the grid 
lines on the mat 
 

The origin will be set at this intersection 
 

Check Absolute (position) 

Design is in same location 

as on the Page 

Verify Assign Tools by 

Color is not checked 

Uncheck Blade Offset 
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• Load the mat into the Skycut and be very precise in alignment by using the ruler to make sure the mat is 
perfectly straight: 

 

• Load the engraver into the Skycut using ~30 Post-It notes (or sheets of copy paper), making sure the notes 
are on top of the tag.  

• Move the cutting head so that the engraver tip is over the intersection of the two grid lines bounding the tag. 
Then use the camera instructions in Section 2.05.1 to set the origin even more precisely by getting the blue 
dashed + in the middle of the grid intersection: 

 

• After clicking on Home, press down on the engraver and verify, once more, that the correct grid intersection 
was used. Back in SignMaster, click on Cut Now and the engraving process will be carried out.: 

 
  

Blue dashed lines cross at 
grid intersection 

Align the mat with the ruler 
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4.05 Settings Form for Accessory Tools 
 

Application/Material Tool Force 
Speed 

(Cut/Up) 
# 

Passes 
Surface Other Comments 

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

© 2009- 2021 Sandy McCauley, All Rights Reserved 
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5. SignMaster Functions of Interest 
 
 
 

5.00 Quick Reference for Chapter 5 
 

• How to add a contour cut: Section 5.01 

• How to node edit a contour: Section 5.01.2 

• How to add a contour cut to a vector image: Section 5.02 

• How to fill a design with engraving lines: Section 5.03 
 
 
 

5.01 Adding a Contour Cut Line to an Imported Raster Image 

• Graphics such as JPG, PNG, and BMP files are often used for print and cut (contour cut) applications. 
Because these types of files are raster images (versus vector images), the images must be traced. This is 
done through a process called vectorization.  

5.01.1 Step-by-Step Tracing Process 

• The following steps are a sample tutorial using the Create Contour Cut feature in SignMaster: 

(1) For this project, go to this link. After extracting, you will find several images that can be used as easy 

samples for tracing.  

(2) To import a graphic file, go to File>Import>File and select the graphic to be traced. Left click anywhere 

in the Drawing Area to place the image: 

 

(3) With the graphic selected, click on the Contour Cutting icon  and select Create Cut Contour. A 

popup window will open and you will respond Yes: 

 

(4) The Image Contour Tracer window displays the various settings available for adding a cut line to the 

graphic: 

https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view
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(5) Without making any changes, click on the Trace button to get a preliminary trace which will indicate 

which settings, if any, need adjustment. The blue line indicates what will cut based on the default 

settings shown: 

 

(6) To see the trace line a little more clearly, adjust the Opacity setting at the top. If the “fit” isn’t tight 

enough, decrease the Smoothing setting. After making changes, click Retrace to return to the original 

tracing window and then click on Trace again: 

 

 

Click here to trace at 
current settings 

Carefully check blue cut line: 

• Are all needed parts 
traced? 

• Is trace line a tight enough 
fit? 

 
 

Decrease Smoothing 
for a tighter trace line 

 

Increase Opacity to better see blue trace line 
 

Option to trace internal 
parts if needed. Refer to 
Section 5.01.2. 
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(7) After making any changes, click on Retrace at the bottom of the screen.  On the other hand, if you are 

happy with the trace results, click on Apply: 

 

 

(8)  If you selected Retrace, a Composite view of the results will appear where blue indicates the part that 

will be cut out and red indicates the waste material.  You can go back to seeing the prior view by 

clicking on the Original tab at the bottom. Click on Trace to apply the new settings.  

 

 

(9)  After clicking on Apply, a new group of settings appear, giving you additional options such as: 

 Whether the cut line is continuous or perforated 

 Whether the cut line fits the image tightly, or is offset a distance or inset a distance 

 Whether internal cut paths should be removed 

 The cornering shape of the contour cut (rounded, beveled, mitered, etc.) 

Click on Apply if satisfied 
with existing trace  

 

Click on Retrace to 
adjust to new settings 

 

Click on Trace  
 

 

Alternate viewing 
options 
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 Choose a Corner Style, as desired. For the Outline % or Outline Units (size), note the following: 

o Set to 0 if the cut line should align with the edges of the printed image 

o Set to a positive number for a contour cut around the outside of the printed image 

o Set to a negative number (normally very small) to cut slightly inside the printed image 

(10)  Click on Accept after making any changes and you will be returned to the Drawing Area. If you click 

on the Objects tab on the Page Thumbnail Viewer, you will now see both the original image and the 

contour cut line: 

    

• To print and cut this type of design, refer back to Sections 3.03 and 3.04. 
 
 

Contour shape options 
 

Contour type options: use 
these settings 

 
 

Click on Accept when done 
 

Original image options 
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5.01.2 Editing a Trace 

• Occasionally you may find a need to edit the tracing/contour cut created. This section presents two 
examples. 

• Contour cut doesn’t fit the original graphic in certain spots 

 In the following example, the Cartoon Owl image will be used: 

 

 During the process of tracing, it was found that the bottoms of the owl’s feet weren’t rounded like in the 
original image. Even trying different adjustments to Smoothing didn’t result in the desired fit. Note that 
a slight inline was applied to improve the accuracy of the fit but the bottom of the feet still need 
tweaking: 

 

 With the trace line selected, click on the Node Edit Tools icon  and the nodes making up the path 
of the cut will appear.  Drag nodes, as needed, so that curves are formed: 

 
 

• Contour cut contains paths you want deleted 

 In the following example, a crab cartoon from Doodle Dragon Studios is traced: 

 
 

 The issue in this example is that the space below the eyes should be cut out but not other internal 
shapes, such as the pupils of the eyes. Note the difference in what will be cut between marking and not 
marking the Keep Holes option in the Create Cut-Contour window: 

Trace line is flat along the bottom of owl’s feet 
 

Drag nodes to create curves 
 

An outside trace is 
needed 

Also needed is a trace of 
this area between the eyes 
and the body 
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 The first option, Keep Holes, needs to be selected so that the area beneath the eyes is traced. After 
accepting the trace, click on the Objects tab on the Page Thumbnail Viewer and hide the original 
graphic. You will now only see the contour in the Drawing Area: 

           

 

 Select the contour and go to Curves>Break Apart. The individual paths will now be separate layers on 
the Objects tab and you can delete each one that is not needed: 

 

     

Keep Holes not 
checked 

 

Area below eyes is traced but so 
are the inner parts of the eyes 

 

Keep Holes 
checked 

 

No inner paths at all 
 

 

versus 
 

 

Delete these 
three layers 

 
 

Paths inside of the 
eyes are gone 

 
Path below eyes is 
part of the contour cut 

 

Select this layer and 
click on Hide icon 
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5.02 Adding a Contour Cut to a Vector Image 

• As mentioned in Section 3.05.2, vector images require a contour cut assignment in print and cut 
applications. For example, the following Batman SVG file is imported into Signmaster and then the Contour 
Cut Wizard window is opened. Note that comparing the View Print only preview with the View Cut only 
preview indicates that the vector file is ready to print but there’s no cut line for the design: 

   

 

• There are two situations to consider: 

 A contour cut will be added to follow the printed design (Section 5.02.1) 

 A contour cut will be added and it will be offset from the printed design (Section 5.02.2) 

 

5.02.1 Contour Cut Which Follows the Printed Design 
 

• Upon importing the SVG file, open the Objects tab of the Page Thumbnail Viewer to display the various 
shapes in the file: 

      
 

What will print What will cut Option to add contour cut 

Click this blue 
arrow 

Click the Objects tab 

All of the shapes 
appear in a list 
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• From the Objects list, click on the shape which represents the contour cut line you wish to use. In this 
example, it is the black shadow layer: 

 

• With that layer selected, go to Edit>Duplicate. A new layer will appear at the bottom at the Objects list and, 
thus, will now be arranged on top of the project: 

 

• This new layer will also be selected.  To assign it as the contour cut, click on the Custom Fill icon 
that is located on the Palette and select Cut Contour from the drop-down menu: 

     

• This newly assigned contour cut layer is given an invisible fill color and will no longer appear on top of the 
imported project. 

 

• If you now go to the Contour Cut Wizard, you can verify that this new cut layer exists on the View Cut 
Only tab: 

 

Select this layer 
 

 

Click here 
 

 
Select Cut Contour 
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5.02.2 Contour Cut Which Is Offset from the Printed Design 

• This section presents the method to be used when the contour cut is not one of the existing vector shapes. 
While this section accesses the Create Cut-Contour window from within the Contour Cut Wizard window, 
note that the same process can be applied by adding the contour from the main screen as was done in 
Section 5.01 (i.e. select shape and go to Contour Cutting>Create Cut Contour). 

• In the earlier screenshot, SignMaster recognizes there is no contour to cut on the View Cut only tab and 
offers the option to add one using the Build button below the preview. 

    

 

 Clicking on Build opens the Create Cut–Contour window: 

 

What will cut Option to add contour cut 

What will cut 

Contour cut layer 
now appears 
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o Corner Style: Usually select either Round or Sharp depending on the nature of the original vector 
and your desired contour 

o Outline (%) or Outline (Units): Enter either a percentage or the actual size for the outline. In the 
prior screeshot, leaving the Outline at 0 results in the contour being the same as the original 
outside vector line. This would result in the same contour cut as was created in the prior Section 
5.02.1. For an outset cut around the printed image, increase Outline to the desired size. For in inset 
or inline cut, decrease Outline slightly so that it’s a negative number: 

▪ Outline is set to 1/8 (0.125) inches: 

       

 

▪ Inline is set to -1/32 (0.03) inches: 

 

 

 

 

 

Select a Corner Style 

Click on Accept when done 

Use these options 

Keep at 0 for cut line 
to follow print line or… 
Increase to add a 
contour cut or… 
Decrease to add an 
inset cut 

Click on View Mode to add the Outline preview 

Outline set to 0.125” 

 Blue line shows size of 
contour around original 
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 After clicking on Accept, the View Cut only preview now indicates a cut path exists and you’re ready to 
proceed: 

 

• Note that text is also a vector shape, thus the contour cut on a text object would be created the same way.  

• Also note that there is a Keep Holes option in the Create Cut-Contour window which controls whether or 
not the contour is a solid outside cut or contains internal cuts following the shape of the vector: 

 Keep Holes not marked: 

 

 Keep Holes marked: 

 

Outline set to -0.03” 

 Blue line shows size of 

inline inside of original 

Leave unchecked 

 A single blue line will 
be cut around the text 

What will cut 

Contour cut layer 
now appears 
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5.03 Engraving Fill 
 

5.03.1 Engraving File Module and Settings 

• If you wish to fill in a shape with a line pattern, SignMaster offers an Engraving Module which can be 

opened by clicking on the Plugins icon  and selecting Engraving Module. 

• The following window opens and you will see your selected shape has already filled with lines: 

 

 

 

 In the top left corner are zooming tools. The View Mode icon can be toggled to add the original selected 
shape to the Preview window, if desired:                      

Click to add original 
shape to Preview 

Zoom 
tools 

Preview 

Engraving 
settings 

Click on 
Accept 

when done 

Check Keep Holes 

 Internal contour cuts are added 
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 Toolpath: There are four options in this menu: 

o None: no fill pattern is created 

o S-Sweep: a line fill pattern in which the tool stays down while filling the entire shape: 
 

 

 

o Line Fill: a line fill pattern in which the tool raises at each side, moves a “row” down, and then 
proceeds to the other side: 

 
 

 

 

o Island Fill: a progressive inset pattern based on the original shape; the tool drops to complete a 
path, raises, moves to the next path, drops to complete that path, etc.. Some shapes work better 
than others with an Island Fill: 

   

 Travel: four angles from which to choose, applying only to S-Sweep or Line Fill patterns: 
 

  
 
 

Original shape appears 

1. Tool start here and 
proceeds to the left 

2. Tool stays down, follows 
path of curve, then crosses 
to the right 3. Tool stays down, follows 

path of curve, then crosses 
to the left, etc. 

1. Tool start here and proceeds to the left 2. Tool raises 

4. Tool raises 3. Tool drops and 
proceeds to the right 5. Tool drops and proceeds to 

the left, etc. 

Diagonal - Up Horizontal 
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 Cut Perimeter: turn on this option if you want the original shape to be engraved as well: 

            

 Cleanup Flange: turn on this option to have an engraving of the original shape, but along the edges of 
the engraving lines. Note that there is also a Flange Offset setting which is a percentage distance from 
the original shape to the engraving lines. These settings are typically not needed with small diameter 
tools, like the Skycut engraver, so you most likely won’t have a need to activate Cleanup Flange.  

 Tool Diameter: The size of the engraving tip, pen nib, embossing tip, or other tool. For the Skycut 
engraver, use 0.004 inches or 0.1 mm. 

 Tool Offset: This setting is the distance between the engraving lines as a percentage of the Tool 
Diameter. Lowering this setting will decrease the spacing between the lines: 

      

 Hatch Offset: This setting controls the distance from the engraving fill to the outside perimeter of the 
original shape, again as a percentage of the tool diameter. A setting of 0% will extend the pattern all the 
way to the perimeter: 

   
 
 
 

Vertical Diagonal - Down 

Perimeter of shape is 
light, indicating it will 
NOT be engraved 

Perimeter of shape is 
dark, indicating it will 
also be engraved 

Cut Perimeter: 
checked 

Cut Perimeter: not 
checked 

Engraving lines are 
much closer together 

Tool Offset: 34% Tool Offset: 15% 

Hatch Offset: 35% Hatch Offset: 25% Hatch Offset: 0% 
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5.03.2 Inside Fills Versus Outside Fills 

• In certain situations, you might want to reverse the parts of a design that are filled. To do this, add any 
outside shape to the design, such as a rectangle, an oval, a heart, etc.  The engraving fill automatically fills 
the space between this new outside shape and the original design. 

 For example, if three stars are sent to the Engraving Module, then they will immediately fill with lines 
such as this: 

 

 If shapes are added around these stars, then the fill pattern reverses to fill the space between the 
original shapes and the new outside shapes: 

 

 

 If another shape is added to the outside of these shapes (a large rectangle is added to encompass the 
three shapes), then the fill will revert back to the original stars and a line fill is added between the 
rectangle and the outside shapes that were added: 

 

• If, for some reason, you want the outside shape present but NOT have the area between the two shapes 
filled, then only select the initial shapes (i.e. the stars) to send to the Engraving Module. 
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Appendix A  Troubleshooting FAQ’s 
 
 
 

A1 Communication Issues 

 

I cannot get the Skycut to power on. 

• Make sure the power cable is securely plugged into the Skycut’s port on the left side and securely 
plugged into a wall socket or a power strip. 

• If it still fails, check the wall socket or power strip with another device, such as a table lamp. 

• If you still cannot get the Skycut powered on, contact your dealer. 

____________________ 

 

I cannot get Wi-Fi to work with my Skycut. 

• Set the Skycut close to the router when performing the initial setup presented in Section 1.12.2.  After 
establishing communication, you can test how far the Skycut can be located from your router. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have selected TCP 
and entered the same IP address you selected during setup on the Skycut’s control panel: 

 

• Make sure your computer is connected to the same router as your Skycut. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

____________________ 

 

I cannot get USB to work with my Skycut. 

• Unplug/replug the USB cable at both the computer and at the Skycut. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have Direct USB 
Port selected under Port Type and the Status says Device Connected. If not, repeat the instructions 
in Section 1.12.1. 

 

• Try a different USB port on your computer. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

• Try a different USB cable.  

 

____________________ 
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I had to cancel a cut. Now my Skycut is no longer responding when I click on Cut Now. 

• There is a reset button on the right side of the Skycut D.  Use a pen or pencil to press and hold for one 
second. You should hear a beep. 

____________________ 

 
 

A2 Operating Issues 

 

The control panel isn’t responding very well. 

• Press control panel icons with your finger and not your fingernail. You can also use a black rubber 
stylus. 

• Make sure the control panel is clean. 

____________________ 

My mat is rotating when the Skycut starts to cut! 

• Two pinch wheels need to be gripping the mat. Move the mat either left or right so that it is under two 
outer pinch wheels and the pinch wheels are aligned under white arrows. Refer to Section 1.09. 

• Make sure you are not trying to force the blade to cut too deeply and/or too quickly through a 
thick/dense material like chipboard or craft plastic.  Slow the speed, decrease the Force, and add more 
passes. 

____________________ 
 
 
My vinyl isn’t feeding evenly while cutting. It starts bunching up on the inside of the end cap. 
 

• Even if you feel the vinyl is aligned properly at the start of the cut, a slight “out of alignment” error will 
become more pronounced with a long cut. When you first drop the pinch wheels, use the arrow keys to 
feed the vinyl for the length of the cut to make sure it is feeding straight. If not, then about half-way 
through the length of the vinyl needed, lift the pinch wheels and realign the vinyl. Continue testing the 
alignment until you can verify that the vinyl is sufficently aligned for the entirety of your project.  

 
____________________ 

 
 
The pinch rollers are not tight enough to hold the vinyl I’m cutting. The vinyl is slipping and rotating when I start 
the cut. 

• The pinch wheels need to be over grit shafts (the dark gray rough areas along the revolving shaft. The 
white rectangles will help you align the pinch wheels in correct locations. Also, use outside locations 
versus having, say, one pinch on the far right of the vinyl and a second pinch wheel only in the middle.  

 
____________________ 

 
 
I hear a terrible stuttering sound when trying to cut chipboard (or other thick dense material). 

• That can be a symptom of forcing the blade to cut too deeply and/or too quickly through the chipboard. 
Slow the speed, decrease the Force, and add more passes. 

 
____________________ 

 



 149 

I’m trying to do a PNC application and the camera can’t read the first reg mark. The light turns red and the 
Skycut starts beeping. 
 

• Make sure the reg mark on the printout is at least 3 inches from the right end cap. Otherwise there isn’t 
enough room for the camera to move to the right to take the photo.  

 
____________________ 

 
 
I’m trying to do a PNC application. The camer reads the first mark and sometimes the second but not the third. 

• Most likely you are not printing at 100% or you have activated Borderless printing in your printer 
properties window. Please refer to this document:  

 
https://tinyurl.com/b36hfcr7 

 
____________________ 

 
 
I’m trying to do a PNC application and the camera can’t read the marks. 

• Make sure you have calibrated the Skycut’s camera. The procedure is covered in Section 3.03. 

• On the control panel, go to Set>Camera and press Set. Make sure the Auto PNC option is marked. 

• If using the cutting mat, make sure the printout is aligned fairly straight on the cutting mat and the mat is 
fairly straight in the cutter.  

• Make sure the blade holder is over the lower right registration mark when starting the cut. 

• Are the registration marks printed dark with no streaking or missing ink?   

• Did you make any changes in the Contour Cutting Wizard after printing and before trying to cut? 
 

____________________ 
 
 
The Skycut stopped during a cut. 

• If the Skycut stops with the head over on the left side of the cutter, you have most likely exceeded the 
cutting range. Several things to consider:  

 Check the width (W) of your project (or the height H if in Landscape mode). It cannot exceed 21.95” 
when cutting with the left head. 

 Check how far you are moving the head to the left when setting the origin. If your project is 21” and 
you moved the head more than 1” to the left, you will send the cut out of range and the cutter will 
stop. 

• If the Skycut stops and the head is not located near the left side: 

 Make sure it’s not a communication issue. 

 You may have exceeded a buffer limit. Try reducing the number of nodes. Select the shapes and go 
to Curves>Node Editing>Reduce Nodes (Object).   

____________________ 

I have sent a project that is supposed to use the right side for scoring and the left side for cutting. Everything is 
set correctly in the software but the left side is used for both the scoring and the cutting. 

• On the Skycut’s main control panel screen, make sure that Use Double Head is selected. 

____________________ 

https://tinyurl.com/b36hfcr7
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A3 Cutting/Drawing Issues 
 

My shapes are drawing (cutting) off the material. What am I doing wrong? 

• When setting the origin, make sure you are using the tip of the blade as the reference point and set the 
tip inside the corner of the material (not too close to an outside edge). 

• Verify that the preview window in SignMaster matches where you expect the shapes to cut as you view 
the material loaded into the Skycut itself. 

____________________ 

 

When drawing with the test pen), I have extra lines being drawn. 

• Make sure you raise the pen in the blade holder seat on the Skycut before tightening the screw. The 
blade holder seat needs to be able to drop the tool down when it reaches the spot to start the shape. 
Otherwise, the tool tip will be dragging across the material from the origin to where the shape will begin 
and then back to the origin at the end of the “cut”. 

____________________ 

 
 
I’m drawing with a pen and there are bubbles at the corners. 

• For perfect corners when using a pen, go to the Send to be Cut window and select Pen Mode so that 
Blade Offset is set to 0. You do not need an offset for pens (or other tools like embossers and 
engravers).  

 

____________________ 
 

 
My cut started out fine but by the end of the cut, it’s not cutting through the material. 

• Make sure the blade holder housing doesn’t have any bits of material inside of it. 

• Make sure the screw on the blade holder seat is hand-tight so that the blade holder isn’t slipping 
upwards during the cut. 

• Make sure the cutting mat is clean and sticky and the material is pressed down completely, so that the 
material remains stabilized during the cut.  

• Make sure the blade isn’t cutting too deep into the mat. This can sometimes cause the material to be 
pulled up and away from the mat as the blade releases from the plastic it is cutting. 

• Try increasing the Force by ~ 5 – 10. 

____________________ 
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My cut is clean in some places but not in others. Why am I not getting consistent cutting? 

• Make sure your material is pressed firmly onto a clean and sticky mat (assuming you are cutting a 
material such as paper or cardstock). 

• Your material may require two passes if it’s not homogenous or if it is heavily textured. Sometimes 
intricate shapes also cut better with two passes. 

• Also, if the material has been exposed to humidity, then it will become difficult to cut in one pass.  You 
can dry both paper and cardstock using a blow dryer or in a very low-temperature oven.   

• If you are cutting vinyl without a cutting mat, check the cutting strip to make sure it is still in good 
condition. 

____________________ 

 
I have the outside edges of my chipboard completely taped but I’m not getting clean cuts, even after lots of 
passes. 

• Taping the edges prevents shifting of the chipboard but it’s not enough for stabilizing. You need to 
thoroughly press the entire surface of the chipboard onto a clean and sticky mat. Using a brayer is 
recommended. 

____________________ 

 
I am getting a lot of tearing in my cuts. 

• A number of things can cause tearing so work through this check list:  

 Too much blade is exposed. If you see cut lines in your mat or the backing sheet, shorten the blade 
exposure. You should only be cutting through the material itself.  

 The blade is chipped. Try a different blade. 

 The paper is not adhered well to the mat. Make sure the mat is clean, sticky, and the paper is 
pressed smoothly and evenly on the surface. 

 You may be using too much Force. Try reducing it and doing test cuts.  

 You may have too many nodes in the shape. Select the shapes and go to Curves>Node 
Editing>Reduce Nodes (Object).   

 The material itself may be subject to tearing, especially on intricate cuts.  Also, if the cardstock has 
been exposed to humidity, then the moisture in the material can make it difficult to cut cleanly. You 
can dry paper and cardstock using a blow dryer or in a very low-temperature oven.   
 

____________________ 

 
I’m cutting very small lettering and the letters are a bit distorted. 

• Verify that you are using the correct Blade Offset. 

• Try slowing down the cut. Small lettering needs slower speed. 

____________________ 

My cut shapes are not the same dimensions as what they are set to in SignMaster. 

• Perform the calibration procedure shown in Section 2.08. 

____________________ 

 
My shapes are not completely cutting out. They are still attached to the waste part of the material.  
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• Make sure you have set an appropriate Overcut setting. 

• Make sure the mat is not skewing during the cut. This can happen if even one of the pinch wheels is no 
longer centered under a white arrow.  It can also happen if the speed and/or pressure is set too high. 

 
_____________________ 

 
My cardstock is not cutting all the way through. I have the blade all the way out and using the maximum force. 

• Please refer to Section 1.07.5. It’s important to only have as much blade exposed as is necessary to 
penetrate the cardstock. You may also need to raise the blade tip height (Section 2.01.3). Reduce your 
force back to suggested values for the material you are cutting and do a test cut. 

• Do not use more force than is needed. If the cardstock is cutting through about 90% of the cut, then 
increase Passes. Some cardstocks do better with a second pass at a lower force. 

____________________ 

 
I calibrated the camera for print and cut but every cut is off by the same amount.  
 

• The calibration can be tweaked using the procedure presented in Section 3.06.1 

____________________ 

 
I calibrated the camera for print and cut and the cuts start off accurate but, by the end of the cut, there is a lot of 
error. 

• This is called “drift” and can sometimes be corrected by slowing the speed and making sure the cuts 
aren’t so deep that the blade is causing some drag to occur.  

• An alternative solution is to add intermediate registration marks. Refer to Sections 3.08 and 3.09.2. 

____________________ 
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Appendix B  Original Camera Calibration 
 
 

B1 Camera Calibration Procedure  

(1) Insert the test pen into the Skycut. Place a sheet of paper into the Skycut. You can use the cutting mat to 
hold the paper or insert the paper directly. 

(2) On the control panel, move the test pen over the sheet of paper. 

(3) Select Speed/Force and set SPEED to ~ 8 and FORCE to ~ 30. Click on Test to verify that a square is 
clearly drawn. If it is too faint, increase FORCE as needed and repeat. 

(4) Move the pen an inch or two away from the test so that there is room for the calibration shape to be drawn. 

(5) On the Main Screen, press Set and then Camera: 

 

 

(6) Press Adjust to switch to calibrate mode and a new Start button will appear in the lower right corner of the 
Camera Screen: 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  

… and Start button appears 

Press Adjust button… 

https://www.youtube.com/watch?v=dOJVNHCDlGA&t=330s
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(7) Press Start. The test shape, which is a square with a + inside, will be drawn on the paper and the camera 

will move over the test shape, take a photo, and display the photo on the control panel. If you cannot see 
the test shape clearly, press the LED button once so that it reads LED 50% and press the Get PIC button. 
You should see three items in the photo: the test shape that was drawn with the pen, a red +, and the blue 
dashed +: 

 

(8) Tap your finger near the middle of the drawn test shape. This will move the red + to that location. Then 
press OK. A new photo will be taken: 

 

(9)  Press X3 so that a magnified version appears: 

 

(10)  Use the arrows keys to move the center of the red + to the center of the test shape: 

 

 

Photo of drawn test shape 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 

It is now much easier to see the 
red +, relative to the center of 
the test shape 

X3 toggles the magnification 
of the image 
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(11)  Press OK and a new photo will be taken. The blue dashed + should now be more closely aligned with the 

center of the test shape: 

 

(12)  If necessary, repeat Steps 10 and 11 until the blue dashed + is near-perfectly centered in the test shape. 

(13)  Press X3 to return to normal magnification. Click on the Home icon to return to the Main Screen. Your 
Skycut is now calibrated for print and cut (PNC) applications. 

 
 
 

B2 Tweaking the Calibration Values 
 
IMPORTANT: The following adjustment method only applies if you are on an older firmware version which 
required you to use the procedure in Section D1 to calibrate the camera. 

• If you find your print and cut results are slightly off in the same direction with each cut, you can adjust the 
values being used versus attempting to recalibrate from scratch.  

• To do this, go back to an easy-to-cut material like copy paper and use a shape that has both horizontal and 
vertical lines. This makes it easier to know if you need to adjust in the X (left-to-right) direction or in the Y 
(up-and-down) direction. The arrow from SCAL’s Library is a good choice since you can use the head of 
the arrow to make sure you put the printout onto the mat the same direction as in the software.   

• After performing the print and cut, use a mm ruler to measure how far off the cut line is from the printed line. 
If you used an arrow, focus only on the horizontal and vertical lines, not the diagonal lines: 

The red + is now 
centered in the test 
shape 

Press the arrow 
buttons to move 
the red + 

Note new location 
of blue dashed + 

IMPORTANT: the red + is 
intentionally moved away from the 
test shape with each new photo so 
that you can more easily see if the 
blue dashed + is centered.  
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 In this example, let’s say the red cut line is about 0.5 mm too high and about 0.3 mm too far to the left. 
Thus, you need the cut line to move down and to the right.  

• On the control panel, change the Units to millimeters by going to Set>General Settings and choosing 
millimeters, as was shown in Section 1.14.2. 

• Go to Set>Camera and click on Adjust. Then click on Set to open the Adjustment window: 

           
 

• One at a time adjust Δx and Δy by pressing the buttons in the direction you need the cut line to move.  
 

           
 
 
 

1. Press Adjust 

2. Then press Set 

Current 
adjustments 
are set to 0.00 

Use these buttons to adjust the 
Δx and Δy offsets to these 
values 
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• Once the values are set, press the Home button to return to the Main Screen.  Test again to verify the cut 
line is better aligned with the printed shape.  

• Important: You can also adjust calibration numbers after a cut has begun! These adjustments will only 
apply for this particular cut but can be very useful in “saving a cut.” Refer to second part of Section 3.07.3 
for instructions.  

 
 
B3 Dual Head Calibration 

• In Appendix D1 the camera calibration is presented showing how to make sure the blade holder is calibrated 
with the camera. A similar calibration is also needed to make sure the right and left blade holder seats are 
perfectly aligned with one another. This then allows you to do accurate draw-and-cut, score-and-cut, 
engrave-and-cut, and other combined tool applications.  

(1) On the control panel’s Main Screen, make sure the Use Double Head option is selected. If you do not see 
any of these options, click on Set>Advanced settings>System mode and select double. Then, back on 
the Main Screen, the options should now be available: 

 
 

(2) Insert a sheet of paper into the Skycut, either on the cutting mat or directly inserted. Load a test pen into 
both the left and right-side blade holder seats, making sure the pen nib is a little ways above the paper, as 
you did in Section 1.13.  You can also use a stack of 35 Post It notes as presented in Section 2.01.3. 

(3) Select the Speed/Force function and make sure both sides are set to a suitable Force for drawing: ~ 30 – 
40.  

(4) Make sure both pens are over the paper. On the Main Screen, select Set>Camera to open the camera 
calibration screen: 

 
 
 
 
 
 
 
 
 
 
 
 
 

Select Use Double Head 
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(5) Press Adjust to switch to calibrate mode and a new Start button will appear in the lower right corner of the 
Camera Screen: 

 

(6) Press Start. A test shape, which is a square with a + inside, will be drawn by the right side pen on the 

paper and the camera will move over the test shape, take a photo, and display the photo on the control 
panel. If you cannot see the test shape clearly, press the LED button once so that it reads LED 50% and 
press the Get PIC button. You should see three items in the photo: the test shape that was drawn with the 
pen, a red +, and the blue dashed +: 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode  

… and Start button appears 

Press Adjust button… 

Photo of drawn test shape 

Red + 

Blue dashed + 
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(7) Tap your finger near the middle of the drawn test shape. This will move the red + to that location. Then 
press OK. A new photo will be taken: 

 

(8)  Press X3 so that a magnified version appears: 

 

(9)  Use the arrows keys to move the center of the red + to the center of the test shape: 

                

(10)  Press OK and a new photo will be taken. The blue dashed + should now be more closely aligned with the 

center of the test shape: 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 

It is now much easier to see the 
red +, relative to the center of 
the test shape 

X3 toggles the magnification 
of the image 

The red + is now 
centered in the test 
shape 

Press the arrow 
buttons to move 
the red + 
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(11)  If necessary, repeat Steps (9) and (10) until the blue dashed + is near-perfectly centered in the test shape.  

(12)  Now move the red + so that it is perfectly aligned with the center of the blue dashed +:  

 

(13)  Press OK and the camera will move to the left side test square and will post an image. Repeat Steps (7) – 

(11). Once the blue dashed + is near-perfectly centered in the test shape, click on the Home icon to return 

to the Main Screen. Your Skycut is now calibrated for dual head applications. 
 
 

 
  

Move red + to align 
with center of blue 

dashed + 

IMPORTANT: the red + is 
intentionally moved away from the 
test shape with each new photo so 
that you can more easily see if the 
blue dashed + is centered.  
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Appendix C Activating Commands 
 

• This section shows you how to activate commands in order to add certain functions to the control panel. 

• Go to Set>Advance settings>System Mode and press the cmd… button: 

 
 

• The following screen opens. Press Input: 

 

• The Input code is entered in the same way as you entered your Network password but since it’s a 3-digit 
code, you’ll begin by pressing the 123 button: 

   

 

Press cmd…  

Press Input  

Numeric keys appear  Press 123  
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• Enter the required Input code according to the following: 

 021: Activate Mark Set  

 020: Deactivate Mark Set 

 031: Activate Passes Set 

 030: Deactivate Passes Set 

• After entering the Input code you need, click on OK and the Input screen will return. The word RUN will 
now be highlighted and you can press it.  The Skycut will beep once. 

   

• Return to the main screen and press USB, the activated button will now appear: 

 

 
 
 
 
 
 

 
 

 

 

Press RUN… 

Enter code by 

pressing keys 

Press OK when done 

Passes Set now 

appears 
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